Copyright and Disclaimer

All rights reserved.

To the extent allowed by law, ColorDirector IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH ColorDirector AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT. BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

ColorDirector is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

International Headquarters

Mailing Address   CyberLink Corporation
                 15F., No. 100, Minquan Rd., Xindian Dist.
                 New Taipei City 231, Taiwan (R.O.C.)
Web Site           https://www.cyberlink.com
Telephone          886-2-8667-1298
Fax                 886-2-8667-1385
Copyright © 2019 CyberLink Corporation. All rights reserved.
## Contents

<table>
<thead>
<tr>
<th>Chapter 1:</th>
<th>1</th>
<th>Introduction</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Welcome</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Minimum System Requirements</td>
</tr>
<tr>
<td>Chapter 2:</td>
<td>5</td>
<td>Importing Videos</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Supported File Formats</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Importing 360° Video Files</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Importing Videos into the Program</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>Downloading Videos from CyberLink Cloud</td>
</tr>
<tr>
<td>Chapter 3:</td>
<td>8</td>
<td>The ColorDirector Workspace</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>ColorDirector Modules</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>Library/Adjustment/Production Panel</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>Keyframe Settings Panel</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>Storyboard Panel</td>
</tr>
<tr>
<td></td>
<td>14</td>
<td>Video Viewer Window</td>
</tr>
<tr>
<td>Chapter 4:</td>
<td>22</td>
<td>ColorDirector Projects</td>
</tr>
<tr>
<td></td>
<td>22</td>
<td>Setting Project Aspect Ratio</td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>Exporting Projects</td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>CyberLink Cloud Projects</td>
</tr>
<tr>
<td>Chapter 5:</td>
<td>24</td>
<td>Utilizing Keyframes</td>
</tr>
<tr>
<td></td>
<td>26</td>
<td>Keyframe Timeline</td>
</tr>
<tr>
<td></td>
<td>30</td>
<td>Adding Keyframes</td>
</tr>
<tr>
<td>Chapter 6:</td>
<td>34</td>
<td>Making Video Adjustments</td>
</tr>
<tr>
<td></td>
<td>35</td>
<td>Histogram</td>
</tr>
<tr>
<td></td>
<td>38</td>
<td>Regional Adjustment Tools</td>
</tr>
<tr>
<td></td>
<td>65</td>
<td>Global Adjustment Tools</td>
</tr>
</tbody>
</table>
Chapter 7:  
82 Using Adjustment Presets
82 Downloading Presets from DirectorZone
83 Downloading Presets from CyberLink Cloud
84 Saving Custom Presets
85 Applying Presets on Videos
85 Sharing and Backing Up Presets
86 Exporting/Import Presets

Chapter 8:  
87 Turning Adjustments On/Off

Chapter 9:  
88 Production
88 Producing Video Files
90 Sharing Videos

Chapter 10:  
95 ColorDirector Preferences
95 General Preferences
96 Project Preferences
96 DirectorZone Preferences
97 Color Preferences
97 Hardware Acceleration Preferences
97 Production Preferences
98 CyberLink Cloud Preferences
98 Improvement Program Preferences

Chapter 11:  
100 ColorDirector Hotkeys
104 Customizing Keyboard Hotkeys

Chapter 12:  
107 Licenses and Copyrights

Chapter 13:  
108 Technical Support
<table>
<thead>
<tr>
<th>Page</th>
<th>Section Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>108</td>
<td>Before Contacting Technical Support</td>
</tr>
<tr>
<td>109</td>
<td>Web Support</td>
</tr>
<tr>
<td>109</td>
<td>Help Resources</td>
</tr>
</tbody>
</table>
Chapter 1:

Introduction

This chapter introduces CyberLink ColorDirector and provides an overview of all its features. It also outlines the system requirements for installing and using the CyberLink ColorDirector program.

**Note**: this document is for reference and informational use only. Its content and the corresponding program are subject to change without notice.

Welcome

Welcome to the CyberLink family of digital media tools. CyberLink ColorDirector is a video editing program that turns your video footage into eye-catching movies through the use of video color creating and correcting. You can then render the videos for use in other editing programs, or for upload to YouTube and Vimeo.

Latest Features

This section outlines the latest features within the CyberLink ColorDirector program.

- Set a matching color tone in your videos with Color Match.
- Use the triple color wheel for advanced Split Toning effects on your videos.
- Utilize keyframes to replace color in videos.
- Save custom color LUT in one of four available formats.
- Copy and paste adjustments from video clip to video clip.
- Customize keyboard hotkeys to your editing preference.

DirectorZone and CyberLink Cloud

You can upload/download color presets, and back up media, preferences, projects, and more with the DirectorZone and CyberLink Cloud features.
**DirectorZone**

DirectorZone is a web service that lets you download adjustment presets created by other users, so you can use them on your videos. You may also share your own custom presets by uploading them to DirectorZone.

To access the benefits of DirectorZone, you can sign in by clicking the button at the top of the window to open the ColorDirector preferences, and then on the **DirectorZone** tab. See **DirectorZone Preferences** for more information.

Also, be sure to periodically click the button to check out the latest **DirectorZone Bulletin**. Just click in this section in the Notifications window to view the bulletin. Or go to https://directorzone.cyberlink.com to find out more information on the features and benefits of the DirectorZone web service.

**CyberLink Cloud**

CyberLink Cloud is a cloud storage service from CyberLink where users can upload and download their presets, ColorDirector projects, produced video clips, and more. CyberLink Cloud allows users to back up media, preferences, projects, etc., and ensure their working environment is the same on multiple computers.

*Note: CyberLink Cloud is a subscription cloud storage service that is included with some CyberLink products, and is available for purchase through our web site. For more detailed information, see https://www.cyberlink.com/products/cyberlink-cloud/**.

**ColorDirector Versions**

The features that are available in CyberLink ColorDirector are completely dependent on the version you have installed on your computer.

Click the CyberLink ColorDirector logo in the top right, or select **Help > About CyberLink ColorDirector** from the menu, to determine the version and build number for your copy of CyberLink ColorDirector.
ColorDirector 365

ColorDirector 365 is a subscription based version of CyberLink ColorDirector that provides all the editing and color correcting features you expect, and adds the CyberLink Cloud storage service and more.

With a ColorDirector 365 subscription, you get:

- All the advanced video color grading features of the Ultra version of CyberLink ColorDirector, including the production of 4K ultra HD video.
- The ability to back up program preferences, projects, custom output profiles, and presets on the cloud storage space CyberLink Cloud.
- Guaranteed updates to the latest versions of CyberLink ColorDirector Ultra.

ColorDirector 365 is the must-have solution for on-the-go video editors who want easy access to their media and the latest up-to-date editing technologies.

Updating ColorDirector

Software upgrades and updates (patches) are periodically available from CyberLink. CyberLink ColorDirector automatically prompts you when either is available.

*Note: you must connect to the Internet to use this feature.*

To update your software, do this:

1. Click the button to open the Notifications window.
2. Check the *New Updates* and *Upgrade Info* sections.
3. Select an item in these sections to open your web browser, where you can purchase product upgrades or download the latest patch update.
Minimum System Requirements

The system requirements listed below are recommended as minimums for using the CyberLink ColorDirector program.

<table>
<thead>
<tr>
<th>System Requirements</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>• Microsoft Windows 10, 8/8.1, 7 (64 bit OS only)</td>
</tr>
<tr>
<td>Processor (CPU)</td>
<td>• Intel Core™ i-series or AMD Phenom® II</td>
</tr>
<tr>
<td>Graphics Processor (GPU)</td>
<td>• 128 MB VGA VRAM (1 GB or higher VRAM and OpenCL capable are recommended)</td>
</tr>
<tr>
<td>Memory</td>
<td>• 4 GB required (8 GB or above recommended)</td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>• 2 GB required</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>• 1024 x 768, 16-bit color</td>
</tr>
<tr>
<td>Internet Connection</td>
<td>• Internet connection also required for initial software and file formats activation</td>
</tr>
</tbody>
</table>
Chapter 2:

Importing Videos

The first step when using CyberLink ColorDirector is to import your videos into the program library. You can import videos one by one, or import the entire contents of a folder into CyberLink ColorDirector.

Supported File Formats

CyberLink ColorDirector supports the following video file formats:

**Videos:** AVI, FLV (H.264), M2TS (H.264 AVC, H.265 HEVC), MKV (H.264 AVC, H.265 HEVC), MOD, MOV, MPEG-1, MPEG-2, MPEG-4 (H.264 AVC, H.265 HEVC), TOD, VOB, VRO, WEBM (VP9 and Opus audio), WMV, XAVC S.

CyberLink ColorDirector also supports Canon & Nikon DSLR video files.

Importing 360° Video Files

You can import and edit video files that were recorded with a 360 camera. Before importing, make sure your project aspect ratio is set to 360°. See Setting Project Aspect Ratio for more information.

*Note:* the 360° video must be stitched before it can be used in a 360° video project in CyberLink ColorDirector. See the documentation for your 360 camera manufacturer for information on stitching the files for viewing and editing.

Once you are done color correcting your 360° video file, you can produce the video and it will be outputted as a 360 video file. See Producing 360° Video for more information.

Setting 360° Projection Format

If CyberLink ColorDirector did not detect your 360° video file and you are sure it has been produced for playback and editing, you can manually set the 360° projection format. You can also disable 360° mode for a file that was mistakenly detected as a 360° video file.

To set the 360° projection format, do this:
1. Right-click on a 360° media file in the media library or on the storyboard, and then select Set 360° Projection Format.

2. Select the 360° projection format by selecting one of the following:
   - **Equirectangular (360°)**: equirectangular video is the standard projection used in 360° video. Equirectangular projection displays the 360° video environment, which is a sphere, onto a rectangular video screen.
   - **2D Format (Not 360°)**: select this option if the selected media file is actually 2D content.

### Importing Videos into the Program

You can import videos into CyberLink ColorDirector from your computer’s hard drive, and from removable devices, such as memory cards and portable hard drives.

To import videos into CyberLink ColorDirector, do this:

1. Click on **Library**, and then on one of the following import options:
   - select to import individual video files. Once selected, browse to and then select all of the videos on your computer/removable device that you want to import, and then click **Open**.
   - select to import a folder that contains your videos. Once selected, browse to and then select the folder on your computer/removable device that you want to import videos from, and then click **Select Folder**.
   - select to download video files you previously uploaded to CyberLink Cloud. See [Downloading Videos from CyberLink Cloud](#) for more information.

2. CyberLink ColorDirector imports the video files into the library.

   **Note**: you can also drag and drop video files onto the CyberLink ColorDirector window to import them into the program.
Downloading Videos from CyberLink Cloud

If you have a CyberLink Cloud subscription you can download videos from your CyberLink Cloud storage directly into the library.

To download videos from CyberLink Cloud, do this:

1. Click on the **File** menu item and then select **Download Media from CyberLink Cloud**. You can also click the button in the library panel.
2. Browse to and then select all the video files you want to download.
3. Click on the **Download** button. CyberLink ColorDirector downloads the selected files and then imports them into the library.
Chapter 3:

The ColorDirector Workspace

This chapter outlines the CyberLink ColorDirector workspace, and all of its features. Getting familiar with the workspace is helpful, because it is where you spend all of your time when using CyberLink ColorDirector.

A - ColorDirector Modules, B - Keyframe Settings Panel, C - ColorDirector Preferences, D - Library/Adjustment/Production Panel, E - Video Viewer Window, F - Storyboard Panel

ColorDirector Modules

CyberLink ColorDirector is comprised of three main modules: Library, Adjustment, and Production.
Library

Click the Library button to import video clips into CyberLink ColorDirector and view detailed information video file information. Once imported into the library, you can add them to the storyboard panel for adjusting and editing. See Library Panel for more information.

Adjustment

The Adjustment module is where you touch up and make adjustments to the video clips you imported into CyberLink ColorDirector. Click the Adjustment button to apply presets, use motion track masks and gradients, adjust video saturation, hue, white balance, effects, and much more. See Making Video Adjustments for detailed information.

Production

Once you finish adjusting your video clips, you must render them in the Production module to apply the adjustments you made. All the video clips in the storyboard panel will be rendered into one longer video once produced in the Production module. For more detailed information see Production.

Library/Adjustment/Production Panel

The panel on the left side of the CyberLink ColorDirector window that displays is dependent on which module of the program you are in. The following outlines each of the panels and some of the available features.

Library Panel

The library panel is where you import all of the video clips into CyberLink ColorDirector. It also provides access to the metadata information for each individual video clip. You can double-click on any video clip in the library to begin playing it in the preview window.
Importing Videos

You can import video files individually or by importing all the videos in a specific folder. See Importing Videos for detailed information.

Sorting Videos in the Library

You can easily sort the videos in the ColorDirector library by selecting a sort option from the list.

You have the option of sorting the videos in ascending or descending order by file name, duration, or the date the videos were created.

Setting Library View

If required you can change the library view to fit your personal preference. By default the video clips in the library display in thumbnail view, but you can click the button in the top right corner of the library panel to change the view.
Select to view the video clips by file name. Select to view them by their video thumbnails.

**Note:** you can click and drag on the divider between the clips library and video information for a larger view of the clips in the library.

**Video Information**

When you select video clips in the library, CyberLink ColorDirector displays each clip's detailed embedded information in the library panel. Included in the information is video and audio codec information, file size and type, video resolution, frame rate, aspect ratio, and more.

**Adding Video Clips to the Storyboard**

Once you have video clips in the library, you must add them to the storyboard to make adjustments and edit them. You can adjust and produce them one at a time, or add multiple video clips that are merged into a longer video.

To add a video clip to the storyboard, do either of the following:

- drag it from the library to the storyboard.
- select it in the library and then click on its thumbnail.
Adjustment Panel

The adjustment panel displays when in the Adjustment module and contains all of the tools you use to color correct, adjust, and add effects to your videos. See Making Video Adjustments for a detailed description of the all the tools available on the adjustment panel.

Production Panel

When in the Production module, you can set produce preferences in the production panel before rendering your adjusted video clips. See Producing Videos for detailed information about the controls on the production panel.

Keyframe Settings Panel

When in the Adjustment module, click on the Manual tab and then the button to display the keyframe settings panel. You can use keyframes when adjusting your video clips to define the start and end points of the applied changes.

See Utilizing Keyframes for more detailed information on this feature.

Storyboard Panel

The storyboard panel is where the videos you want to adjust are located.

A - Video Clips, B - Scene Detection

Select a video in the storyboard panel to display it in the video viewer window for playback and adjustment.

Note: all the video clips in the storyboard panel will be rendered into one longer video once produced in the Production window. If you do not want the video clips rendered together, you must add each of them to the storyboard separately, and then adjust and produce them one by one.

While browsing through video clips in the storyboard panel, you can:
CyberLink ColorDirector 8

- rearrange the order of the video clips in the storyboard panel, just select it in the panel and then drag it to the new position.

- remove a clip from the storyboard panel, right-click on it and then select **Remove**. You can also remove multiple video clips at once by holding down the Ctrl key on your keyboard, selecting the clips in the panel, and then clicking the **button at the top of the video viewer window.

- right-click on a video clip in the storyboard panel and then select **Open File Location** to view the file in Windows Explorer.

- a video clip thumbnail with the **icon in the storyboard indicates that adjustments were made on the clip.**

- click on the **icon in a video clip's thumbnail to detect any scenes that the clip may contain. The detected scenes are added to the storyboard panel like any other video clip. See **Detecting Scenes in Video Clips** for more detailed information on this feature.

  **Note:** you cannot detect scenes in a video clip that was previously trimmed or split.

- double-click in the video viewer canvas area to hide the storyboard panel from view and get a larger view of the current video (viewer only mode). Double-click on it again to redisplay the storyboard panel (viewer & storyboard mode).
Video Viewer Window

The video viewer window displays a preview of the video selected in the storyboard panel. Any adjustments you make to videos are viewable this window.

![](image)

A - Trim Video, B - Scene Detection, C - Split Video, D - Remove Video, E - View at Full Screen, F - Secondary Monitor Display Mode, G - Select Viewer Display Mode, H - Select View Mode, I - Viewer Zoom, J - Player Controls, K - Playback Options, L - Motion Tracking Controls, M - Enable 360° Viewer Mode, N - Render Preview, O - Video Timecode Display

Trimming Video Clips

Use the trim function to quickly trim off unwanted portions at the beginning and end of a video clip in the storyboard panel.

To trim a video clip, do this:

*Note: the trim function is only available when in the Library and Adjustment modules.*

1. Select the video clip in the storyboard panel you want to trim, and then click on the button at the top of the video viewer window to open the Trim window.

2. Use the player controls to find where you want the trimmed clip to begin, or the mark in position.

3. Click and drag the mark in and mark out indicators to positions where you want the clips trimmed.
You can also manually set the timecodes for the In position and Out position using the up and down arrows as required.

4. Click OK to set your changes and trim the clip as specified.

When trimming videos clips, please note:

- use the Duration controls if you want to trim the video clip to a specific length.
- to preview what the trimmed clip will look like, ensure Output is selected and then click the play button.
- if required, you can reenter the Trim window to refine the trimmed clip at any time.

Detecting Scenes in Video Clips

The scene detection function automatically detects the individual scenes (or pre-edited shots) contained within a video clip, and then separates them into multiple clips. The detected scenes are added to the storyboard panel like any other video clip.

**Note:** the detected scenes are not split from the original clip, but can be separately moved around or removed from the storyboard panel.

To detect the scenes in a video clip, do this:

**Note:** you cannot detect scenes in a video clip that was previously trimmed or split. The detect scenes function is only available when in the Library and Adjustment modules.

1. Select a clip it in the storyboard panel and then click the button at the top of the video viewer window to open the Scene Detection window. You can also click the icon on the video clip's thumbnail in the storyboard panel.

2. The scenes in the video clip are automatically detected and then displayed in the Scenes panel.

3. Once you are done detecting the scenes in the video clip, click the OK button. All the separate clips that were detected are now visible in the storyboard panel.
The ColorDirector Workspace

When using scene detection, please note:

- if required, use the **Sensitivity** slider to increase or decrease scene detection sensitivity. Doing this may yield an increased or decreased number of scenes that are detected. Click **Start** to redetect the scenes in the video clip. You are asked to confirm the clearing of the previously detected clips and then the updated scenes are detected and displayed in the Scenes panel.

- click on the **button to configure the Advanced Scene Detection Settings. If the selected video clip is a DV-AVI file, you have the option to **Detect by change of video frame** (used on all other file formats) or **Detect by change of timecodes** (i.e.: time codes are automatically set when you start and stop recording). Select the **Disable preview during detection** option to speed up the detection process if you find your computer runs slow during the process.

- to stop the scene detection process before completion, click the stop button on the playback controls.

- to detect scenes manually, drag the slider (in **Clip mode**) to the beginning of each new scene and then click [ ].

- to preview a detected scene, just select it in the Scenes panel (ensure **Scene** is selected) and then click the play button.

- to view all the detected scene markers on the clip timeline, ensure that **Clip** is selected.

- to merge two or more detected scenes into one longer scene, select them in the Scenes panel and then click **Merge**. Click **Remove All** if you want to restore the clip to the original.

**Splitting Video Clips**

You can quickly split a video clip that is in the storyboard panel into two separate clips. To do this, move the timeline slider (or use the player controls) to the position in the clip where you want to split it. Next, click the [ ] button to separate it into two clips that you can then move around and adjust separately from one another.

*Note: the split function is only available when in the Library and Adjustment modules.*

You can also use it to quickly remove unwanted portions of a video clip, or if you want to insert other media between the two portions.
Rendering a Preview

When in the Adjustment module or viewing a video at full screen, you can click and drag one of the yellow markers on either side of the timeline slider to select a range of the video clips on the storyboard.

Once selected, click **Render Preview** to have CyberLink ColorDirector render a video preview of only the selected range. Once rendered, click the play button for a smoother preview of color adjustments in the selected range.

Selecting Viewer Display Mode

The video viewer window has several display modes that let you more easily view the adjustments made to video clips. Click the arrow next in the viewer display mode section to view all of the available display modes.

*Note:* these display mode buttons are only available when in the Adjustment module of CyberLink ColorDirector.

- **Show one** - shows one preview window for the selected video clip in the storyboard panel.
The ColorDirector Workspace

- **Side by side** - select to compare adjustments to videos side by side.

- **Split - left/right** - select to split the video, with the left half containing the original video, and the right half of the video with the adjustments applied.

- **Top/bottom** - select to compare adjustments to videos top to bottom.

- **Split - top/bottom** - select to split the video, with the top half containing the original video, and the bottom half of the video with the adjustments applied.

**Secondary Monitor Display Mode**

If you have more than one monitor connected to your computer, click the button and then select the display mode for the secondary monitor.

*Note: for this button to display, you must connect a secondary display to your computer and then enable extend desktop to a secondary display in the Windows Display Properties Settings.*

- **Mirror** - duplicates the viewer display on the secondary monitor.

- **Alternate** - provides a secondary view of the videos you are adjusting. For example, if you are adjusting a video in side by side mode, the "After" video displays at full screen on the secondary monitor.

- **None** - select if you don’t want anything displayed on your secondary monitor.

**Selecting View Mode**

In the top left of the video viewer window, select one of the following view modes when browsing through and viewing videos in CyberLink ColorDirector:

- **Viewer & Storyboard Mode** - select to display the video viewer window and the storyboard panel for easy browsing and viewing of videos.

- **Viewer Only Mode** - select to display a larger view of the videos.
**Note:** you can double-click in the video viewer canvas area to hide the storyboard panel from view and get a larger view of the current video (viewer only mode). Double-click on it again to redisplay the storyboard panel (viewer & storyboard mode).

When playing back videos in the program or when making adjustments, select 📺 to view the current video at full screen. When in full screen mode, click 🎞️ to exit.

**Note:** when in full screen mode you can render a selected range for smoother playback. See Rendering a Preview for more information.

### Viewer Zoom

When previewing videos in the video viewer window, use the zoom drop-down in the top right corner to set the size of the video preview.

**Note:** you can also hold down the Ctrl key on your keyboard and then use the mouse scroll wheel to zoom in or out on the video viewer window.

Select **Fit** to resize the selected video so that it fits in the viewer window.

**Note:** if you find that the size of the video in the video preview window seems quite small when **100%** zoom is selected, and becomes distorted after selecting **Fit**, check that the quality setting of the video is correct. See Playback Options for more information.

When you zoom in or out on a video clip, a navigation thumbnail for the viewer displays in the bottom right of the video frame. Click and drag the available box to change the focus area to suit your zooming requirements.

### Video Player Controls

Select a video clip in the storyboard panel and then click the 🎥 button to begin playing it back. CyberLink ColorDirector will just play back the selected clip when the play button is clicked. If you want to play all the clips in the storyboard, click the 🎥 button to enter full screen mode, and then click 🎥 to play the whole movie.
Use the video playback controls available in the video viewer window to control playback, including pausing/stopping playback, fast forwarding videos, jumping to the previous/next frame, or adjusting the volume. You can also click and drag the playback slider to quickly go to a specific timecode in the timecode display, if necessary.

**Playback Options**

Click the button to access the following playback options:

- **Quality**: select to set the quality of the video in the video viewer window. For best results it is recommended that you set this based on the quality of the original video.

- **Real-time Preview**: select one of the following preview modes:
  - **Real-time Preview**: synchronizes and renders clips and effects in real-time, displaying a preview of your video at the standard 25 (PAL)/30 (NTSC) frames per second.
  - **Non Real-time Preview**: mutes the audio and displays a preview at a reduced speed to help make editing much more fluid. Useful when editing high-definition video on a less powerful computer, or when you receive dropped frames when previewing. By muting the audio and slowing down the video, CyberLink ColorDirector lets you view more frames per second when your computer has trouble providing a smooth preview during editing.

**Motion Tracking Controls**

The motion tracking controls are available when on the motion tracking mask tab of the Regional Adjustment Tools. They are used when applying regional adjustments on moving objects in videos. See Using a Motion Tracking Mask for more detailed information.

**Playing 360° Video Files**

After 360° video files are added to the storyboard, they can be played back in 360° viewer mode. To play video files in 360° viewer mode, do this:
CyberLink ColorDirector 8

1. First, ensure your project's aspect ratio is set to 360°. See Setting Project Aspect Ratio for more information.

2. Select the 360° video file on the storyboard.

3. Click 🎥 to enable the 360° viewer mode.

4. Click the play button to start playing it back.

5. Use the 360 controls to view and explore the 360° environment.

   Note: you can also click and drag your mouse in the preview window to explore the 360° environment.

360 Controls

When playing a 360° media file, you can click and drag on the preview window to pan around the 360° environment or use the controls to pan left, right, up, or down. Note that you can click the "−" in the middle of the controls at any time to reset to the default viewing position.

Note: you can also use your mouse's scroll wheel to zoom in and out within the 360° view. To exit the 360° viewer mode, press the Esc key on your keyboard or click the X in the top right corner of the window.
Chapter 4:

ColorDirector Projects

When adjusting video clips in CyberLink ColorDirector, click the button to save your work as a project in the .cds file format, which is used exclusively by CyberLink ColorDirector.

*Note:* a CyberLink ColorDirector project (.cds) file essentially contains a list of the video clips in the storyboard panel, and a log of all the edits and adjustments you want to make to them. Project files do not include the video clips in them. If you want to save all your video production files in one place, use the Pack Project Materials function. To do this select, *File > Pack Project Materials* from the menu.

Use the options in the *File* menu to save, create new, or open existing projects in CyberLink ColorDirector. If you have a CyberLink Cloud subscription you can also upload saved projects and more to CyberLink Cloud. See *CyberLink Cloud Projects* for more information.

*Note:* when you create a new project, CyberLink ColorDirector resets your library. If you want to create a new video production using the same media that’s currently in your library, select *File > New Workspace*.

The changes you make to your video clips in CyberLink ColorDirector do *not* affect the original videos you imported into the program. Since your edits are all saved in the project file, you can trim and make adjustments to your clips, but still keep your original files on your hard drive, untouched. So let yourself get creative. If you end up changing things too drastically, you can always start over.

### Setting Project Aspect Ratio

To set the aspect ratio for your project, select from the available options in the aspect ratio drop down at the top of the window.
The video viewer window changes according to the aspect ratio you select.

If the video you imported is a 360° video file, your project aspect ratio should be 360° so you can edit and produce it as a 360° virtual reality video. See Importing 360° Video Files for more information on importing them, and Producing a 360° Video for information on outputting them in the 360° video format.

Exporting Projects

You can export your CyberLink ColorDirector projects by packing all the materials in a folder on your computer's hard drive or CyberLink Cloud*. Exported projects can then be imported into another computer running CyberLink ColorDirector.

*Note: if you have CyberLink PowerDirector 11 or above installed on your computer, you can also select File > Export Project to PowerDirector from the menu to quickly send all the individual adjusted video clips in the storyboard directly to the PowerDirector timeline.

To export your project, select File > Pack Project Materials. If you have a CyberLink Cloud subscription you can select File > Pack Project Materials and Upload to CyberLink Cloud to back it up in a folder on CyberLink Cloud.

CyberLink Cloud Projects

If you have a CyberLink Cloud subscription you can select File > Upload Project to CyberLink Cloud to store project files on CyberLink Cloud.

To open a project that was saved on CyberLink Cloud, including projects that were packed in a folder with their media (materials), select Download Project from CyberLink Cloud from the File menu or in the Welcome window. In the window that displays, select a project and then click Download.

*Note: when you open a packed project stored on CyberLink Cloud, the project file and all the project media is downloaded to your local computer and stored in the download folder specified in CyberLink Cloud Preferences.
Chapter 5:

Utilizing Keyframes

By default when you are color correcting and adding color grading on video clips, the adjustments are applied to every single frame in the video, i.e. the entire video clip. However, you can use keyframes to only apply the adjustments on just the frames of video you want modified, by defining the start and end points in the keyframe settings panel.

*Note: not all of the adjustments can utilize keyframes. You can check which adjustments allow keyframing in the keyframe settings panel.*

When in the Adjustment module, click 🕒 to open the keyframe settings panel.
CyberLink ColorDirector 8

You can use keyframes to define the start and end points of every type of adjustment in CyberLink ColorDirector, giving you full control over the process. Every adjustment item has keyframe controls for the timeline in the keyframe settings panel.

To use keyframes when making adjustments to video clips, do this:

1. Select the video clip in the storyboard and then click the button to display the keyframe settings panel.

2. Use the keyframe timeline to find the frame in your video clip where you want the adjustments to begin and end. See Keyframe Timeline for more information.

3. Add keyframes as required to mark where the adjustments begin and end. See Adding Keyframes for more information.
Utilizing Keyframes

**Note**: keyframes are also added to the keyframe timeline if you change the shape, position, or size of a regional adjustment mask.

4. Make adjustments to your video clip as required. See [Making Video Adjustments](#) for more information.

## Keyframe Timeline

A custom keyframe timeline is generated for each video clip you import into the storyboard panel and is visible in the keyframe settings panel. In the below example, because the video clip is 15 seconds long, the keyframe timeline is also 15 seconds.

The timeline slider position corresponds to the position of the playback slider and the timecode display in the video viewer window.
You can click and drag the edge of the keyframe settings panel to change the size of the timeline and the video in the preview window.

You can also zoom in on the keyframe timeline for a more precise placement of keyframes. To zoom in or out on the timeline, just click on the timeline ruler and
Utilizing Keyframes

drag it left or right, or use the slider at the bottom of the adjustment panel.

In the above example, the timeline is zoomed in to the frame level. Each line on the timeline ruler, now represents a frame of video.

**Timeline Markers**

You can add timeline markers to the keyframe timeline ruler for more precise adding of keyframes.

*Note: all timeline markers added to the timeline in CyberLink ColorDirector, are available on the clip marker track if you export your project to PowerDirector. See Exporting Projects for more information on exporting projects.*

**Adding Timeline Markers**

To add a timeline marker, do this:

1. Hover your mouse over the keyframe timeline ruler. The blue timeline marker indicator displays the current time.
2. Once you have found the time where you want to place the timeline marker, right-click on the ruler and then select **Add Timeline Marker**, or press the M key on your keyboard.

3. Input a **Note** for the new timeline marker, if required.

4. Click on **OK** to add the new timeline marker.

Note that the timeline marker is also added to the storyboard timeline.

5. You can then just click on the added timeline marker to align the timeline slider to it. This makes it easy to add keyframes at this precise moment in your video clip.

**Note**: you can manually drag a keyframe timeline marker to different position if the original is not in the exact location you wanted it. Expand the keyframe timeline ruler for a more precise placement, if necessary.

Right-click on the keyframe timeline ruler and then select **Manage Markers** to view a list of all the timeline markers you have added. In this list you can remove any of
the existing markers, or hover your mouse over the Note column and then click to edit the associated text.

Adding Keyframes

Any time you make a change to an adjustment item using one of the sliders, or change the size, shape, or position of a regional adjustment mask, a keyframe is automatically added to the keyframe timeline.

**Note**: even if you want an adjustment to be made on the entire duration of a video clip, CyberLink ColorDirector automatically adds a keyframe at the beginning of the keyframe timeline.

To manually add keyframes to the keyframe timeline, do this:

1. Click on to open the keyframe settings panel.

2. Click on next to the adjustment item you want to change to add a keyframe at the beginning of the keyframe timeline.

**Note**: you can add timeline markers to the keyframe timeline to ensure the keyframe is placed at the exact moment you want to make the adjustment. See Timeline Markers for more information.

3. Use the player controls to find the moment in your video clip where you want its properties to change (make adjustments).
4. Drag the sliders as required, making the adjustments to the video clip that you want to make. Note that a keyframe marker is added at that moment in timeline.

5. Right click on the first of the two keyframes to set how and when the adjustment/change is applied. See Setting Keyframe Behavior for more detailed information.

6. Repeat these steps to add more keyframes to the timeline, and for all the adjustments you want to make on the video clip, if required.

**Setting Keyframe Behavior**

If you have added two keyframes to the timeline and made the same adjustments, right click on the first keyframe to set the behavior, or when the adjusted properties will display in the video clip.

To set the behavior, right click on the first keyframe and then select one of the following keyframe behavior options:

- **Gradual Change from Current Keyframe**: select this option if you want the adjustment/change to be made gradually between the two keyframes. By the time the playback slider reaches the second keyframe, the adjustment/change is fully applied.
• **Instant Change at Next Keyframe**: select this option if you want the adjustment/change to be applied instantly once the playback slider has reached the second keyframe.

• **Instant Change at Current Keyframe**: select this option if you want the adjustment/change to be applied instantly once the playback slider has reached the first keyframe.

---

### Modifying and Removing Keyframes

At any time you can modify the keyframes added, by selecting it in the timeline and changing the corresponding adjustments.

You can also do the following:

- to remove a keyframe, select it on the timeline and then click ⌃.
- click ⌃ to quickly jump to the previous keyframe, or ⌥ to jump to the next one.
- click on ⌃ to remove and reset all keyframes on the selected timeline.
• right click on any keyframe on the keyframe timeline and then select **Reset to Default Value** to reset the adjustment back to the original setting. Note that the keyframe is not removed, the adjustment is just reset.
Making Video Adjustments

Chapter 6:

Making Video Adjustments

Click on the Adjustment button and then on the Manual tab to begin making adjustments to your video clips. Any adjustments you make are not auto-applied to the original video file. CyberLink ColorDirector keeps a log of all the adjustments you want to make, and then applies them to each video clip when it is rendered in the Production module. This leaves the original video clip untouched.

Adjustments can be made both globally (on the entire video frame, see Global Adjustment Tools and Effects) or regionally (on a specified area of the video frame only, see Regional Adjustment Tools). You can also apply adjustments to only the video frames you want to using keyframes. See Utilizing Keyframes for detailed information.

To make adjustments on video clips in the library, do this:

1. Select the video clips in the library panel that you want to adjust, and then drag and drop them into the storyboard panel.
   
   **Note:** you can add more than one video clip to the storyboard panel for adjusting. However, all the video clips in the storyboard panel will be rendered into one longer video once produced in the Production window. If you do not want the video clips rendered together, you must add each of them to the storyboard separately, and then adjust and produce them one by one.

2. Click on the Adjustment button.

3. Select the specific video clip in the storyboard that you want to adjust.

4. Make all the adjustments on the video clip as required.
   
   **Note:** you can also choose to apply adjustment presets to instantly transform your video clips. See Using Adjustment Presets for more information.

5. If required, select another video clip in the storyboard and make adjustments.

6. When you are done adjusting each video clip in the storyboard panel, click on the Production button to render them with the adjustments applied. See Production for more detailed information.
**Histogram**

The histogram is a graphical representation of the color tone distribution in a selected video. During the playback of a video clip, the histogram values will continually change, indicating how the lighting in the video image changes.

To find the histogram, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. The **Histogram** is at the top of the Manual tab.

The X axis of the graph represents the RGB color tone value between 0 and 255, while the Y axis indicates the number of pixels in the video that have this value.

The histogram is created with the three RGB (red, green, and blue) color values given to each pixel in the video image. The gray portions indicate where all three colors overlap on the histogram, while yellow, magenta, and cyan appear when two of the colors overlap. Click R, G, or B to view the red, green, or blue color channel values only in the histogram. Click RGB to return to the original histogram display and display all the channels.

**Applying Color Look-up Tables (CLUT)**

Use the color lookup table (CLUT) to transform the range of colors in a video clip to another range. Doing this can completely change the color scheme of the video, and ensure all your video clips have the same look.

You can search for and download color lookup tables in a variety of formats (3DL, CMS, CSP, CUBE, M3D, MGA, RV3DLUT, VF), and then import and then use them in your CyberLink ColorDirector projects.

To apply a color lookup table to a video clip, do this:
1. Select the video clip on the storyboard you want to apply the color lookup table to.

2. Click on **Adjustment** and then on the **Manual** tab (if necessary).

3. The **Histogram** is at the top of the Manual tab. Click on the histogram.

4. Select the **Apply color lookup** table check box.

5. Click on the palette and then select the color lookup table you want to use. Click on **Open** to finish the selection.

    **Note:** once the color lookup table is selected you can preview how the video will look with it applied. Based on the before and after preview, you can choose to apply the changes, select another color lookup table, or cancel out of the window.

6. If required, select the **Apply to All** button if you want to apply the selected color lookup table on all of the video clips that are currently on the storyboard.

7. Click **Apply** to set the changes.

You can save all the adjustments you made on a video into a custom preset, so that you can use them on other video clips.

### Creating Custom Color Lookup Tables (CLUT)

You can create your own custom color lookup table based on adjustments you make on a video. The CLUT can be saved in one of the four available formats (.3DL, .CUBE, M3D, .MGA), and can be imported into other programs such as CyberLink PowerDirector.

To create a custom color lookup table, do this:

1. Click on **Adjustment**.

2. Make all the required adjustments.

3. At the bottom of the **Manual** tab click on **Create > Color Lookup Table**.

4. In the Create Color Lookup Table window, enter the following information:

   - **Description**: enter a description for the new CLUT.
   - **Copyright**: enter in any copyright information for the new CLUT.
   - **Quality**: select a quality for the CLUT.
CONVERTING VIDEOS TO BLACK AND WHITE

You can instantly convert a selected video clip to black and white, i.e. replace the colors with grayscale.

To convert, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. The **Histogram** is at the top of the Manual tab.
3. Select **B&W**. To convert back, select **Color** on the top of the histogram.

   **Note:** After you convert a video to black and white, the Black and White section of the adjustment panel is enabled. See **Black and White** for details on adjusting the lightness in black and white videos.

VIEWING EXPOSED AREAS

The **histogram** can also be used to determine if the video was shot correctly. A video clip with a histogram that arcs towards the left, indicates the video was underexposed (contains a lot of dark pixels), while one that arcs towards the right means there was an overexposure (lots of lighter pixels).

Click  to view the areas of the video image that were so over and underexposed that all detail was lost, or clipped, in that area.
Making Video Adjustments

The areas that are overexposed are indicated in red. The areas of the video image that are underexposed, in blue. Click 🗑️ to hide these areas.

Regional Adjustment Tools

Use the regional adjustment tools if you want to modify only a specific area of the video frame in your selected video clip.

The following sections outline the features and functions available in the regional adjustment tools of CyberLink ColorDirector. To begin using a regional adjustment tool, just select it from the available icons.

Using a Selection Mask

A selection mask lets you select only the pixels in a video clip that you want to adjust. This allows you to select and adjust static objects in the video clip.

**Note:** the selection mask is ideal for adjusting areas of video in videos clips where the camera or objects in the area are motionless. If the camera is moving or objects move in the frame, try using a motion tracking mask. See Using a Motion Tracking Mask for more information.
Creating a Selection Mask

To create a selection mask and use it to make adjustments, do this:

*Note: you can adjust multiple areas of the video using selection masks. See Using Multiple Selection Masks for more information.*

1. Click on Adjustment and then on the Manual tab (if necessary).

2. In the Regional Adjustment Tools section, click 🎨 to open the selection mask controls.

3. Use your mouse to manually select the area of the video frame you want to adjust. You do this by clicking around the outline of the area until an enclosed section is selected.
Note: to create horizontal or vertical lines using straight line control, just hold down the Shift key on your keyboard when adding node points. You can adjust the shape of the selection mask by clicking and dragging the nodes. Click and drag the connected white nodes to use a Bézier curve to better fit the mask to rounded edges.
Note: click a node to select it, and then press the Delete key on your keyboard to delete it. To add a new node, just hover your mouse over the line edge and click to add the required node.

4. Use the **Feather** slider to set the transition level between the area being selected and the pixels around the area. This slider is not enabled until a masked area has been defined on the video frame.

**Note:** CyberLink ColorDirector displays a mask color marker on the area you select. Right click on the mask color marker for more selection mask options.

5. Make the required adjustments to the selected part of the video frame using the regional adjustment options. See **Regional Adjustment Options** for a detailed description of all the available adjustments you can make.

**Note:** if required, click the button to invert the selected pixels. When selected, CyberLink ColorDirector will apply the adjustments to areas that were not selected. Click it again to revert the adjustments back to the pixels selected originally.

### Adjusting Mask Position and Shape

If the selection mask you created appears off at any point during the duration of the video clip, you can easily adjust its position or shape.

**Note:** when you adjust the position or shape of a selection mask, CyberLink ColorDirector automatically adds a keyframe to the keyframe settings timeline to mark the change. See **Utilizing Keyframes** for more information on keyframes.
To adjust the selection mask position/shape, pause the video clip playback at the point when you want to make the adjustment and then do any of the following:

- click on a mask node to select it and then drag it to a new position to change its shape.
- click on a mask node to select it, and then press the Delete key on your keyboard to delete it, if required.
- to add a new mask node, just hover your mouse over the line edge and click to add the required node.
- click on the mask color label and then drag the entire mask to a new position.
- right click on the mask color label for more options, including selecting all nodes, duplicating the mask, deleting the mask, resetting the adjustments, and more.

**Using Multiple Selection Masks**

You can make up to five different selected adjustments on a video. When you select areas of the video and modify the adjustment options, a mask is auto created and labeled by color.

The mask label is visible in the Mask drop-down at the top of the selection mask tab.

To create a new adjustment mask, do this:

1. Select **New** from the Mask drop-down to create a new mask.
2. Use your mouse to manually select the area of the video frame you want to adjust, and then use the sliders to set the adjustments as required for the second adjustment.

3. CyberLink ColorDirector labels the mask with another color in the Mask drop-down.

![Mask drop-down](image)

4. CyberLink ColorDirector marks each mask on the video with the color label.

![Masked video frame](image)

5. Click the color label to quickly select the mask, and view the selected areas (pixels) of the video where each of the adjustments was applied.
**Duplicating Masks**

You can also duplicate an existing mask by right clicking on the color label, and then selecting **Duplicate Mask**.

This new mask can be moved and reshaped as required. The original mask's regional adjustments are not duplicated.
Using a Motion Tracking Mask

Use a motion tracking mask to adjust areas of the video that have moving objects, or when the camera moves in a video clip. When you apply the motion tracking mask on a set of pixels, CyberLink ColorDirector will auto track the pixels as they move through each video frame, adjusting the mask shape and applying the same adjustments to them.

Creating a Motion Tracking Mask

To create a motion tracking mask and use it to make adjustments, do this:

1. Click on Adjustment and then on the Manual tab (if necessary).

2. In the Regional Adjustment Tools section, click to open the motion tracking mask controls.

3. Use the playback controls to find the first frame of video where the object or camera begins moving.

4. Set the mask options as follows:
Note: selecting **Auto edge selection** will make selecting pixels to the object's edges easier. Deselect this option to manually select the pixels with more precision.

- **Brush/Eraser**: click on **Brush** and then use the mouse to select the pixels of the object or area you want to track. Click on **Eraser** if you make some errors using the brush and want to remove pixels that are selected.

- **Size**: use the slider to set the size of the brush or eraser. You can also use the mouse scroll wheel to adjust the diameter of the brush/eraser.

- **Feather**: use the slider to set the transition level between the area being selected and the pixels around the area.

Note: the **Feather** slider is not enabled until a masked area has been defined on the video frame.

5. When you are done selecting all the pixels of the object for tracking, click on . CyberLink ColorDirector starts tracking the pixels as they move through the frame. Click the button (Ctrl+M) if you only want to track the movement for one frame of video.
6. Click the button at any time if you want to stop the motion tracking. If you don't click this button, CyberLink ColorDirector tracks the pixels until it can no longer detect movement or the pixels are no longer available, i.e. off screen or obstructed.

7. Once the motion tracking has stopped, make the required adjustments to the selected part of the video frame using the regional adjustment options. See Regional Adjustment Options for a detailed description of all the available adjustments you can make.

Note: if required, click the button to invert the selected pixels. When selected, CyberLink ColorDirector will apply the adjustments to areas that were not selected. Click it again to revert the adjustments back to the pixels selected originally.
Re-tracking a Motion Tracking Mask's Position and Shape

If the motion tracking mask you created appears off at any point during the duration of the video clip, you can easily adjust its position or shape, and then re-track the movement.

*Note*: when you adjust the re-track the position or shape of a motion tracking mask, CyberLink ColorDirector automatically adds a keyframe to the keyframe settings timeline to mark the change. See Utilizing Keyframes for more information on keyframes.

To re-track a motion tracking mask's position or shape, do this:

1. Pause the video clip playback at the point when you want to make the change to the mask.
2. Do either of the following:
   - use the brush or eraser to adjust the mask shape as required.
   - right click on the mask color label for more options, including duplicating the mask, deleting the mask, resetting the adjustments, and more.
3. Click \( \) to re-track the movement with the adjusted shape or position. Click \( \) if you want to track the pixels one frame at a time.
4. CyberLink ColorDirector re-tracks the pixels within the mask from this point, adding a keyframe to the keyframe settings panel to note the change.

Using Multiple Motion Tracking Masks

You can make up to five different selected adjustments on a video. When you select areas of the video and modify the adjustment options, a mask is auto created and labeled by color.

The mask label is visible in the Mask drop-down at the top of the motion tracking mask tab.

To create a new adjustment mask, do this:
1. Select **New** from the **Mask** drop-down to create a new mask.

2. Repeat the steps in [Creating a Motion Tracking Mask](#) to create the motion tracking mask, and then use the regional adjustment option sliders to set the adjustments as required for the second adjustment.

3. CyberLink ColorDirector labels the mask with another color in the **Mask** drop-down.

4. CyberLink ColorDirector marks each mask on the video with the color label.

5. Click the color label to quickly select the mask, and view the selected areas (pixels) of the video where each of the adjustments was applied.
Duplicating Masks

You can also duplicate an existing mask by right clicking on the color label, and then selecting **Duplicate Mask**.

You can use the brush or eraser to adjust the new mask's shape as required. The original mask's regional adjustments are not duplicated.
CyberLink ColorDirector 8

Using a Gradient Mask

Use the gradient mask to apply adjustments gradually across a large area of a video.

*Note: the gradient mask is ideal for adjusting areas of video in videos clips where the camera or objects in the area are motionless.*

Adding a Gradient Mask

To add a gradient mask and use it to make adjustments, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).

2. In the **Regional Adjustment Tools** section, click to open the gradient mask controls.

3. Click and drag on the video to set the gradient across a portion of the video. CyberLink ColorDirector displays a mask color on the area you apply.
Note: the mask's color disappears as soon as you start adjusting the gradient mask options. Right click on the mask color marker for more selection mask options.

4. Make the required adjustments to the selected part of the video frame using the regional adjustment options. See Regional Adjustment Options for a detailed description of all the available adjustments you can make.
Adjusting Mask Position and Size

If the gradient mask you created appears off at any point during the duration of the video clip, you can easily adjust its position or size.

**Note:** when you adjust the position or size of a gradient mask, CyberLink ColorDirector automatically adds a keyframe to the keyframe settings timeline to mark the change. See Utilizing Keyframes for more information on keyframes.

To adjust the gradient mask position/size, pause the video clip playback at the point when you want to make the adjustment and then do any of the following:

- click on a mask line and expand/contract the size, or rotate the mask if clicking on the middle line.
- click on the mask color label and then drag the entire mask to a new position.
- right click on the mask color label for more options, including duplicating the mask, deleting the mask, resetting the adjustments, and more.

Using Multiple Gradient Masks

You can use up to five gradient masks on a video in CyberLink ColorDirector. When you modify the adjustment options and use the gradient mask on the video, CyberLink ColorDirector auto creates a mask labeled by color.

The mask label is visible in the **Mask** drop-down at the top of the gradient mask tab.

To create a new gradient mask, do this:

1. Select **New** from the **Mask** drop-down to create a new mask.
2. Click and drag on the video to set the gradient across a different portion of the video.

3. Use the sliders to set the adjustments as required for the second gradient mask.

4. CyberLink ColorDirector labels the mask with another color in the Mask drop-down.

5. CyberLink ColorDirector marks each gradient mask on the video with the color label.

6. Click the color label to toggle the masks on and off, and view the areas of the video where the gradient was applied.
Duplicating Masks

You can also duplicate an existing mask by right clicking on the color label, and then selecting **Duplicate Mask**.
This new mask can be moved and reshaped as required. The original mask's regional adjustments are not duplicated.
Using a Radial Filter

The radial filter tool lets you apply regional adjustments in an elliptical shaped masked area. You can use the radial filter to highlight a specific area of the video image, or to manually create a vignette effect.

To use the radial filter, do this:

1. Click on Adjustment and then on the Manual tab (if necessary).

2. In the Regional Adjustment Tools section, click to open the radial filter tools.

3. Click and drag on the video image to create an ellipse around the area you want to highlight. Once the ellipse is drawn, you can resize it by clicking and dragging any of the four white nodes to create the exact shape you need. Click the green node to rotate the ellipse. You can also click anywhere inside the ellipse to move it to another location on the video image.

Note: CyberLink ColorDirector displays a mask color on the area in the ellipse. The mask disappears as soon as you start adjusting the radial filter options. See Using Multiple Radial Filter Masks for more information.

4. Make the required adjustments to the selected part of the video image using the regional adjustment options. See Regional Adjustment Options for a detailed description of all the available adjustments you can make.
Making Video Adjustments

Note: when you start making adjustments on the video image, CyberLink ColorDirector applies the adjustments outside the created ellipse. Select the button if you want the adjustments applied inside the ellipse. You can also use the Gradient slider to set the size of the gradient on the edges of the radial filter ellipse.

Adjusting Radial Filter Position and Shape

If the radial filter created appears off at any point during the duration of the video clip, you can easily adjust its position or shape.

Note: when you adjust the position or shape of a radial filter, CyberLink ColorDirector automatically adds a keyframe to the keyframe settings timeline to mark the change. See Utilizing Keyframes for more information on keyframes.

To adjust the radial filter's position/shape, pause the video clip playback at the point when you want to make the adjustment and then do any of the following:

- click on a radial filter's mask node to select it and then drag it to a new position to change its shape.
- click on the radial filter's mask color label and then drag the entire mask to a new position.
- right click on the radial filter's mask color label for more options, including duplicating the mask, deleting the mask, resetting the adjustments, and more.

Using Multiple Radial Filter Masks

You can use up to five radial filter masks on a video in CyberLink ColorDirector, allowing to highlight multiple areas of the video image. When you create a radial filter ellipse on a video image, CyberLink ColorDirector auto creates a new mask labeled by color.

The mask label is visible in the Mask drop-down at the top of the radial filter panel.

To create a new radial filter mask, do this:

1. Select New from the Mask drop-down to create a new mask.
2. Click and drag on the video image to create an ellipse around the new area you want to adjust.

3. Use the sliders to set the adjustments as required for the second radial filter mask.

4. CyberLink ColorDirector labels the mask with another color in the **Mask** drop-down.

5. CyberLink ColorDirector marks each radial filter mask on the video image with the color label.

*Note: to remove a mask from a video image, just click its color label node and then press the Delete key on your keyboard.*

6. Click the color label to toggle the masks on and off, and view the areas of the video image where the radial filter was applied.
**Duplicating Masks**

You can also duplicate an existing mask by right clicking on the color label, and then selecting **Duplicate Mask**.
This new mask can be moved and reshaped as required. The original mask's regional adjustments are not duplicated.
Regional Adjustment Options

When making regional adjustments with the selection mask, motion tracking mask, gradient mask, or the radial filter, the following options are available to you.

White Balance

- **Temperature**: use to adjust the color temperature in the selected region of the video image. A negative value applies a colder temperature, while a positive value applies an atmosphere that is warmer.
- **Tint**: use to adjust the color level in the selected region of the video.

Tone

- **Exposure**: use to adjust areas of the video image that are over or underexposed. A negative value darkens overexposed areas, while a positive value lightens underexposed areas.
- **Brightness**: use to adjust the brightness in parts of the video image.
- **Contrast**: use to adjust contrast, or the difference between light and dark areas of the video image.
- **Clarity**: use to adjust the clarity of details in the video image.
- **Vibrance**: use to make the colors in areas of the video image brighter and more vivid, by enhancing the duller colors.
- **Saturation**: use to adjust the intensity of a color in certain areas of the video image.

HDR Effect

See HDR Effect for a detailed explanation of the HDR effect options available on the selected areas of your video.
Level

See Level for a detailed explanation of the Level options available on the selected areas of your video.

Curve

See Curve for a detailed explanation of the Curve options available on the selected areas of your video.

Hue

Use the Hue sliders to fine tune the shade or purity of a specific color in the selected region of the video image. Use the sliders to adjust the eight color band ranges as required.

Note: if you converted the selected video to black and white, the Hue section is not available.

You can also use the tool to target the adjustments on a specific color in the selected region. To do this, click to enable the tool, and then click and (while holding the mouse button down) drag on the color. Drag the mouse up to increase its hue, or down to decrease it in the targeted color.

Saturation

Click on Saturation to adjust the saturation of color in the selected region of the video image. Dragging the sliders to right increases the amount of that color in the video image, while dragging it to the left reduces it. If you drag the slider all the way to the left, you can completely remove a color from the selected section of the video image.

Note: if you converted the selected video to black and white, the Saturation section is not available.

You can also use the tool to target the adjustments on a specific color in the selected region. To do this, click to enable the tool, and then click and (while
holding the mouse button down) drag on the color. Drag the mouse up to increase its saturation, or down to decrease it in the targeted color.

**Lightness**

Click on **Lightness** to adjust color brightness in the selected region of the video image. For each of the eight colors listed, you can adjust how light or dark the specific color is.

*Note: if you converted the selected video to black and white, the Lightness section is not available.*

You can also use the tool to target the adjustments on a specific color in the selected region. To do this, click to enable the tool, and then click and (while holding the mouse button down) drag on the color. Drag the mouse up to increase its lightness, or down to decrease it in the targeted color.

**Color Replacement**

See [Color Replacement](#) for a detailed explanation of the Color Replacement options available on the selected areas of your video.

**Blur**

Enable the **Blur** option to apply a soft focus blur effect on the selected region of the video image. Use the **Blur degree** slider to adjust the amount of blur applied.

**Tint Filter**

Enable the **Tint Filter** option to apply a mono-tone color on the selected region of the video image.

Once enabled, use the Tint Filter controls on the selected region as follows:

- **Hue**: use this slider to set the mono-tone color used on the selected region of the video image.
CyberLink ColorDirector 8

- **Intensity**: use this slider to set the intensity of the mono-tone color. Dragging the slider right makes the colors more saturated, while dragging it left makes them less saturated.

**Color Splash**

See [Color Splash](#) for a detailed explanation of the Color Splash options available on the selected areas of your video.

*Note*: Color Splash is only available when using a motion tracking mask on video clip that was not converted to black and white.

**Global Adjustment Tools**

Use the global adjustment tools to modify the entire frame of a video clip. The following sections outline the features and functions available in the global adjustment tools of CyberLink ColorDirector.

**White Balance**

Use white balance for color correction or you can use it to adjust the color temperature of the video image to create a specific atmosphere. A warmer color shifts light toward the yellows and reds; a colder color shifts light toward the blues and greens.

To adjust the atmosphere of a video using white balance, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Global Adjustment Tools**, go to the **White Balance** section.
3. Drag the **Temperature** slider to adjust the color temperature in the video image. A negative value applies a colder temperature, while a positive value applies an atmosphere that is warmer.
4. Drag the **Tint** slider to adjust the color level of the video image.

To use white balance to color correct the video image, click ![pencil](#) and then use the eye dropper to select a pixel in the video image that you believe should be grey.
CyberLink ColorDirector auto corrects the color in the video image.

**Tone**

In this section of the adjustment panel, the sliders available adjust the tone of the entire video image, while the Tinge sliders let you modify the clarity, vibrancy, and saturation levels.

To adjust the tonal level of your videos, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Global Adjustment Tools**, go to the **Tone** section.

**Adjusting the Color Tone**

Use the available sliders as outlined below to adjust the color tone of the entire video.

**Tone**

Click 🌟 to have CyberLink ColorDirector automatically adjust the color tone in the selected video.

*Note: once the auto adjustments are applied, click ⏳ to view them in the keyframe settings panel.*

You can manually adjust color tone using the available sliders as follows:

- **Exposure**: use on videos that are over or underexposed. A negative value darkens the all the colors in the video, while a positive value lightens them.

- **Contrast**: use to adjust contrast, or the difference between light and dark areas of the video image.
• **Brightest**: use to brighten/darken the colors in the video image that are close to whites. Darkening the lighter colors can enhance their contrast and make highlights stand out more. Drag the slider left to darken, reducing the clipping in highlights. Drag it right to brighten and clip the colors that are close to white.

• **Bright**: is applied to areas of the video image that are overexposed, which can recover detail in the highlights and brighter areas. Drag the slider left to recuperate lost detail in highlights by darkening them. Drag it right to brighten the video image without clipping the brighter areas.

• **Midtone**: use to adjust the overall brightness of the video image by changing the midtone colors only. Drag the slider left to darken, or right to brighten.

• **Dark**: can be used to help enhance detail in dark sections of the video image by brightening shadows and underexposed areas. Drag the slider left to darken the video image without clipping the shadows. Drag it right to recuperate lost detail in shadows by brightening them.

• **Darkest**: use to brighten/darken the colors in the video image that are close to blacks. Brightening the darker colors can enhance their contrast and make shadows stand out more. Drag the slider left to darken and clip the dark colors. Drag it right to brighten and reduce clipping in shadows.

**Tinge**

Manually adjust the sliders to adjust the video image tinge as follows:

• **Clarity**: use to adjust video image clarity. Dragging the slider to the right makes the video image appear crisper, while to the left makes it appear more "dreamy".

• **Vibrance**: use to make the colors in the video image brighter and more vivid, by enhancing the duller colors.

• **Saturation**: use to adjust the saturation of color in the video image. A negative value moves the colors towards black and white, while a positive value increases the overall intensity of color in the video image.
Dehaze

Apply dehaze to videos by dragging the Amount slider right to brighten the colors to make the video image appear less hazy.

Level

In the Level* section of the adjustment panel you can redefine the color in videos by adjusting the color levels. You can adjust using the available presets or manually with the histogram.

*optional feature in CyberLink ColorDirector. Check the version table on our website for detailed versioning information.

Note: *optional feature in CyberLink ColorDirector. Check the version table on our website for detailed versioning information.

To use Level to redefine the colors of an entire video, do this:

1. Click on Adjustment and then on the Manual tab (if necessary).
2. In Global Adjustment Tools, go to the Level section.

Redefining the Colors

To redefine the color using the available presets, select a preset from the Level preset drop-down list that best suits the selected video.

To manually redefine the color in the video, do this:

1. Select whether you want to adjust just the R (red), G (green), or B (blue) color channel levels. Select RGB to adjust all three levels at once.

Note: if the video is in black and white, the only channel available is for luminance, or overall brightness of the video.

2. Click to display the midtone controls.
3. Click and drag the sliders to adjust the color levels in the video.
Note: in the above example, the colors in the video are changed by redefining how many pixels should have a value of 0.

Dragging the sliders on the left, right, make the colors in the video darker. While dragging sliders left make the colors brighter.

**Curve**

In the Curve section you can use the tone curve graphs to change the tonal scale, or overall contrast of a video's image.

To use Curve to change the tonal scale, do this:

1. Click on Adjustment and then on the Manual tab (if necessary).
2. In Global Adjustment Tools, go to the Curve section.

   ![Curve Section](image)

**Adjusting the Curve**

You can use one or all of the four tone curve graphs to adjust tonal scale of the video image. Just click on a curve and drag it up or down, or use the tool to target the adjustments on a specific tonal region of the video image.

You can adjust each tone curve graph as follows:

- **RGB channel**: use this graph to adjust all of the colors in the video image. If you click on the curve and drag it down, the video image becomes darker. When dragged up, the video image becomes lighter.
Making Video Adjustments

- **Red channel**: use this graph to only adjust the red in the video pixels. If you click on the curve and drag it down, you will remove the red from the video image. When dragged up, the video image becomes darker red.

- **Green channel**: use this graph to only adjust the green in the video pixels. If you click on the curve and drag it down, you will remove the green from the video image. When dragged up, the video image becomes darker green.

- **Blue channel**: use this graph to only adjust the blue in the video pixels. If you click on the curve and drag it down, you will remove the blue from the video image. When dragged up, the video image becomes darker blue.

  **Note**: click the curve graph's corresponding button at any time to reset a curve back to its default setting.

**Detail**

You can adjust the sharpness in a video in the Detail section. The sharpness is applied to edges in the video image to enhance detail in the video clip, where possible.

To adjust the video image sharpness, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Global Adjustment Tools**, go to the **Detail** section.
3. Use the Detail controls on a selected video as outlined below.

**Adjusting Sharpness**

To adjust the sharpness in the video image, use the available sliders as follows:

- **Amount**: use this slider to adjust the amount of sharpness applied to the video image.

- **Radius**: use the slider to adjust the radius or range of sharpness applied to edges in the video image.

  **Note**: to see the radius mask, ensure that **Show affected areas** is selected. When enabled, dragging the slider lets you see the applied range of sharpness.

- **Edge Mask**: use the slider to apply a mask on the detected edges in the video image. Once a mask is applied, CyberLink ColorDirector only applies the sharpness to the masked areas, leaving the surrounded areas untouched.
Note: to see the edge mask, ensure that Show affected areas is selected. When enabled, dragging the slider lets you see the detected edges in the video.

Noise Reduction

Applying sharpness and other adjustments to videos may result in some image noise appearing on them. Use the following sliders to reduce the noise as required:

Note: you can also click the button to have CyberLink ColorDirector automatically reduce the image noise in the selected video clip. Once the auto denoise is applied, click to view the adjustments in the keyframe settings panel.

- **Luminance**: use this slider to slightly adjust the color brightness, by reducing any unwanted light grey spots in the video image that cause luminance noise.

- **Detail**: use this slider to adjust/recover detail in the video image that may be lost when reducing luminance noise from a video.

- **Color**: use this slider to slightly adjust the overall color saturation, by reducing any unwanted color spots in the video image that cause color noise.

- **Detail**: use this slider to adjust/recover detail in the video image that may be lost when reducing color noise from a video.

Hue

Use Hue to fine tune the shade or purity of a specific color in the video image.

To fine tune hue, do this:

1. Click on Adjustment and then on the Manual tab (if necessary).
2. In Global Adjustment Tools, go to the Hue section.
3. Use the sliders to adjust the eight color band ranges as required.

Note: if you converted the selected video to black and white, the Hue section is not available, and is replaced by the Black and White section. See Black and White for details on adjusting the lightness in black and white videos.

You can also use the tool to target the adjustments on a specific color in the video image. To do this, click to enable the tool, and then click and (while holding the mouse button down) drag on the color. Drag the mouse up to increase its hue, or down to decrease it in the targeted color.
**Saturation**

In the **Saturation** section you can adjust the saturation of color in the video image.

To fine tune saturation, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Global Adjustment Tools**, go to the **Saturation** section.
3. Use the sliders to adjust the eight color band ranges as required. Dragging the sliders to the right increases the amount of that color in the video image, while dragging it to the left reduces it. If you drag the slider all the way to the left, you can completely remove a color from the video image.

   *Note: if you converted the selected video to black and white, the Saturation section is not available, and is replaced by the Black and White section. See Black and White for details on adjusting the lightness in black and white videos.*

You can also use the tool to target the adjustments on a specific color in the video image. To do this, click to enable the tool, and then click and (while holding the mouse button down) drag on the color. Drag the mouse up to increase the color's saturation, or drag it down to decrease it in the targeted color.

**Lightness**

Use **Lightness** to adjust color brightness.

To fine tune lightness, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Global Adjustment Tools**, go to the **Lightness** section.
3. Use the sliders to adjust the eight color band ranges as required. For each of the eight colors listed, you can adjust how light or dark the specific color is.

   *Note: if you converted the selected video to black and white, the Lightness section is not available, and is replaced by the Black and White section. See Black and White for details on adjusting the lightness in black and white videos.*

You can also use the tool to target the adjustments on a specific color in the video image. To do this, click to enable the tool, and then click and (while
holding the mouse button down) drag on the color. Drag the mouse up to increase
the color's brightness, or drag it down to decrease, making the color darker.

**Black and White**

When you convert videos to black and white, this section becomes enabled,
replacing the Hue, Saturation, and Lightness sections. In it you can adjust the
grayscale levels, or overall video image lightness on the converted clips.

To change the grayscale levels, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In the histogram, convert the video to black and white.
3. In **Global Adjustment Tools**, go to the **Black and White** section.
4. Use the **Lightness** sliders to adjust the brightness of the original colors, which
are now black and white.

You can also use the tool to target the adjustments on a specific color (shade
of gray) in the video image. To do this, click to enable the tool, and then click
and (while holding the mouse button down) drag on the color. Drag the mouse up
to increase the brightness of the color, or drag it down to decrease it.
Split Toning

In the Split Toning section of the Adjustment panel you can produce creative effects on your videos, such as the Lomo effect, using up to three colors. You can also add color to monochrome videos, or videos you converted to black and white.

To use Split Toning on a selected video, do this:

1. Click on Adjustment and then on the Manual tab (if necessary).
2. In Global Adjustment Tools, go to the Split Toning section.
3. Choose whether to use 2-way or advanced 3-way split toning.

2-way Split Toning

Use the 2-way Split Toning controls on a selected video as outlined below.

Highlights

Use the sliders to adjust the hue and saturation of the highlights, or the brightest areas of a selected video.

- **Hue**: use this slider to set the hue or color of the highlights in the video image. You can also click and then use the eye dropper to select the precise color (both hue and saturation) you want used in the highlights.
- **Saturation**: use this slider to set the saturation of the color used, or its amount/strength. Dragging the slider right makes the color more saturated, while dragging it left makes it less saturated.

Balance

- use the Balance slider to set the balance between the split toning effect applied on the highlights and shadows in the video image. Drag the slider left to increase the influence of the Shadows sliders on the video image, drag it right to increase the influence of the Highlights sliders. Set the Balance slider's value to 0 if you want both the effects on the highlights and shadows equally applied.
Shadows

Use the sliders to adjust the hue and saturation of the shadows, or the darkest areas of a selected video.

- **Hue**: use this slider to set the hue or color of the shadows in the video image. You can also click and then use the eye dropper to select the precise color (both hue and saturation) you want used in the shadows.

- **Saturation**: use this slider to set the saturation of the color used, or its amount/strength. Dragging the slider right makes the color more saturated, while dragging it left makes it less saturated.

3-way Split Toning

Use the advanced 3-way Split Toning controls on a selected video as outlined below.

- **Highlights**: click and drag in the color wheel to adjust the hue and saturation of the video's highlights, and the slider to adjust the brightness of the added color.

- **Midtones**: click and drag in the color wheel to adjust the hue and saturation of the video's midtones, and the slider to adjust the brightness of the added color.

- **Shadows**: click and drag in the color wheel to adjust the hue and saturation of the video’s shadows, and the slider to adjust the brightness of the added color.

Effects

You can use effects to transform your video clips. The following sections outline the features and functions available in CyberLink ColorDirector effects.

Color Match

In this section of the adjustment panel, the Color Match feature lets you change the color in a selected video clip, by matching it to another video clip or image.
Making Video Adjustments

To use Color Match, do this:

1. Click on Adjustment and then on the Manual tab (if necessary).
2. In Effects, go to the Color Match section.
   
   Note: you can only match the color in one clip at a time.
3. Click to select the source video or image file, or the media file whose color you want the target clip (clip on storyboard) to match.
4. In the reference window, drag the slider to find the frame that has the exact color you want to match.
5. Click the Match Color button to match the colors.
6. Use the Brightness and Color sliders to adjust the strength and look of the matched colors.

HDR Effect

In this section of the adjustment panel, use the sliders to apply an HDR effect on your videos. The HDR (high dynamic range) effect adjusts the lighting range on the edges in the video image, allowing you to recover any loss of detail caused by contrasting brightness during video exposure. Users can also use this effect to give videos a more dramatic tone.

To apply the HDR effect to an entire video, do this:

1. Click on Adjustment and then on the Manual tab (if necessary).
2. In Effects, go to the HDR Effect section.

Applying the HDR Effect

Use the available sliders as outlined below to apply the HDR effect.

Glow

Use the Glow sliders as follows to apply an HDR glow effect, or a "halo" edge, on contrast edges in the video image:

- **Strength**: use this slider to adjust the amount of the HDR glow effect applied to the video image.
• **Radius**: use the slider to adjust the radius of the HDR glow effect, or the amount of contrast applied to the edges in the video image.

• **Balance**: use the slider to adjust the balance (where it is applied) of the HDR glow effect. Moving the slider right applies it on the brighter parts (highlights) of edges. Moving it left applies it to the darker parts (shadows) of edges.

**Edge**

Use the Edge sliders as follows to apply the HDR effect on contrast edges in the video image:

• **Strength**: use this slider to adjust the amount of the HDR edge effect applied to the video image. Dragging it right will reveal more detail on the contrast edges. Dragging it left will blur them.

• **Radius**: use the slider to adjust the radius of the HDR edge effect, or the amount of contrast applied to the edges in the video image.

• **Balance**: use the slider to adjust the balance (where it is applied) of the HDR edge effect. Moving the slider right applies it on the brighter parts (highlights) of edges. Moving it left applies it to the darker parts (shadows) of edges.

**Color Replacement**

In the Color Replacement section you can replace a color in a video clip with a completely different color.

*Note*: if you converted the selected video to black and white, the Color Replacement section is not available.

To replace a color in the selected video clip, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Effects**, go to the **Color Replacement** section.
3. Click the **Paint** button and then use the eye dropper to select the color in the video image you want to replace. You can also click the box in the Original Color section and choose the color you want to replace in the color palette window.
4. Use the **Tolerance** slider to set the range and amount of the replaced color.
5. In the New Color section, use the **Hue**, **Saturation**, and **Lightness** sliders to set the color you want to replace the original with.

**Blur**

The **Blur** option in the Adjustment panel applies a soft focus blur effect on the entire video image.

To apply a soft focus blur effect, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Effects**, go to the **Blur** section.
3. Use the **Blur degree** slider to adjust the amount of blur applied.

**Tint Filter**

The **Tint Filter** option applies a mono-tone color on the entire video image.

To apply a tint filter, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Effects**, go to the **Tint Filter** section.
3. Use the Tint Filter controls on the selected video clip as follows:
   - **Hue**: use this slider to set the mono-tone color used on the video image.
   - **Intensity**: use this slider to set the intensity of the mono-tone color. Dragging the slider right makes the colors more saturated, while dragging it left makes them less saturated.

**Vignetting Effect**

You can add custom vignetting effects to videos in CyberLink ColorDirector.

To add a custom vignetting effect, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Effects**, go to the **Vignetting Effect** section.
3. Use the Vignetting Effect controls on the selected video clip as follows:
CyberLink ColorDirector 8

- **Shade**: use this slider to adjust the shade of the vignetting effect. Dragging the slider to the left darkens the corners of the video image towards black, while dragging it right lightens them towards white.

- **Size**: use this slider to adjust the size of the vignetting effect. Dragging the slider to the left increases the size of the vignette effect, closing in a circle on the center of the video image.

- **Roundness**: use this slider to adjust the overall shape of the vignetting effect.

- **Feather**: use this slider to adjust the edge sharpness of the vignetting effect. Dragging the slider to the left makes the edge blunt, while to right uses more of a gradient.

**Color Splash**

Use Color Splash to keep only a color you select in a video clip.

*Note: if you converted the selected video to black and white, the Color Splash section is not available.*

To keep only a chosen color in the selected video clip, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Effects**, go to the **Color Splash** section.
3. Click the button and then use the eye dropper to select the color in the video image you want to keep. All the other colors in the video image become black and white.

*Note: you can also click on and choose the color you want to keep in the color palette window.*

4. Use the **Tolerance** slider to adjust the range of color that is kept. Dragging it right will allow more color into the video image. Dragging it left will remove more color.

5. Use the **Hue shift** slider to adjust the shade of the remaining color. You can completely change the color using this slider, if required.

**Color Shift**

The Color Shift feature allows you to easily remap all of the colors in a video clip, completely changing its look.
**Note**: if you converted the selected video to black and white, the Color Shift section is not available.

To remap the colors in a video clip, do this:

1. Click on **Adjustment** and then on the **Manual** tab (if necessary).
2. In **Effects**, go to the **Color Shift** section.

In the Color Shift section there are two color bands. The color band on the bottom is a color wheel, which you use to shift the colors in your video clips.

![Color Shift](image)

To shift all of the colors in a selected video clip, just click and drag the color wheel left or right (or click on the left/right arrows provided) until you get the desired results.

![Color Shift](image)

The color band on the top indicates the original color mapping in the video clip. You can reset the color shift by dragging the color wheel back to its original position, or clicking to reset the changes.
CyberLink ColorDirector 8

Copying Adjustments

When you have finished applying adjustments to a video clip, you can copy all of the adjustments you made and apply them to other videos by pasting them. This is useful if you shot several videos in the same lighting environment and you need to apply similar adjustments.

To copy and apply adjustments to other videos in the library, do this:

1. At the bottom of the Adjustment panel (Manual tab), click **Copy**.
2. In the Adjustment Copy window, select or deselect any adjustment types as required. This allows you to customize the copied adjustments if required.
3. Click the **Copy** button.
4. In the storyboard, browse to and select all of the videos you want to apply the adjustments to.
5. Click the **Paste** button at the bottom of the adjustment panel to apply the adjustments to the selected videos.
Chapter 7:

Using Adjustment Presets

Adjustment presets are a saved set of adjustments that you can apply to your video clips. You can also download and import presets created by other users, or save your own to use on other video clips or share them by uploading to DirectorZone.

Click on Adjustment and then the Presets tab to display the available adjustment presets.

When browsing through the available presets, click to view a thumbnail preview of each preset on the currently selected video clip. You can also view the presets in list view by clicking.

Downloading Presets from DirectorZone

CyberLink ColorDirector supplies you with some custom adjustment presets that you can use on your videos. On the Presets tab, these default adjustment presets are available in the Default Presets section.

To download additional adjustment presets from DirectorZone, do this:

1. Click on Adjustment and then on the Presets tab.

2. Click on or the Download more from DirectorZone link. CyberLink ColorDirector launches DirectorZone in your default web browser.

3. You must first sign in to DirectorZone to download templates. If you don’t have an account, click the Create Account link at the top of the page to get one for free.

4. Select the ColorDirector tab to display all the available adjustment presets you can download.

5. Find a preset you want to download, and then click the Download link underneath it.

6. Click Download again.
7. Save the template to your computer. Find the location on your computer where you saved the preset file, and then double-click on it to install it in the Presets window.

**My DirectorZone Presets**

In the My DirectorZone window you can conveniently download the custom presets that you previously uploaded to DirectorZone. You can also access and download presets from your DirectorZone download history and also your favorite presets.

To download My DirectorZone presets, do this:

1. Click on Adjustment and then on the Presets tab.
2. Click on the Presets tab.
3. Click the My DirectorZone tab.
4. Filter the presets by My Uploads, Download History, or My Favorites, or enter a search keyword in the field provided.
5. Select all of the presets you want to download.
6. Click Download to download them to your computer and import them into the library.

*Note: the presets you download are available in the Downloaded Presets section of the Presets tab.*

**Downloading Presets from CyberLink Cloud**

If you have a CyberLink Cloud subscription you can download the presets you previously backed up to CyberLink Cloud. Once downloaded, these presets are stored in the download folder specified in CyberLink Cloud Preferences, and imported into the presets library on the Presets tab.

To download presets from CyberLink Cloud, do this:

1. Click on Adjustment and then on the Presets tab.
2. Click on the Presets tab.
3. Click the **My CyberLink Cloud** tab.

4. Filter the presets by selecting a collection from the drop-down, or enter a search keyword in the field provided.

5. Select all of the presets you want to download.

6. Click **Download** to download them to your computer and import them into the presets library.

   *Note: the presets you download are available in the **Downloaded Presets** section of the **Presets** tab.*

**Saving Custom Presets**

You can save all the adjustments you made on a video into a custom preset, so that you can use them on other video clips.

To save a custom adjustment preset, do this:

1. Click on **Adjustment** and then on the **Presets** tab.

2. Click on ![Create Preset](image) when on the Presets tab, or at the bottom of the **Manual** tab click on **Create > Preset**.

3. In the New Preset window, enter the following information:

   * **Preset name**: enter a custom name for the new preset.

   * **Save in**: select which preset folder on the Presets tab you want to save the preset in. Select **New Folder** if you want to save the custom preset in a new folder.

3. Select or deselect any adjustment types as required. This allows you to customize the adjustment if required.

   * **Note**: by default, all adjustment types are selected.

4. Click the **Save** button.

   * **Note**: before saving the preset, click the **Upload** button if you want to upload it to DirectorZone or back it up on CyberLink Cloud. See **Sharing and Backing Up Presets** for more information on uploading presets to DirectorZone.
Applying Presets on Videos

You can apply any of the adjustments presets on the Presets tab on video clips in the storyboard.

To apply adjustment presets on videos, do this:

1. Click on Adjustment and then on the Presets tab.
2. Select the video clips that you want to apply presets to in the storyboard panel.
3. Hover your mouse over each available preset to preview the current video with the adjustment applied.
4. Click on the adjustment preset you want to use to apply it.
5. If required, use the Strength slider to adjust the intensity of the applied preset.

Sharing and Backing Up Presets

You can share your customized presets with other CyberLink ColorDirector users by uploading them to DirectorZone. If you have a CyberLink Cloud subscription you can back up all your customized presets by storing them on CyberLink Cloud.

To share and back up your presets, do this:

1. Do one of the following:
   - in the New Preset window, enter a name for the custom preset, and then click Upload.
   - select the preset in the My Created Presets section of the Presets tab, and then click .
   - right click on the preset in the My Created Presets section of the Presets tab, and then select Upload to DirectorZone/CyberLink Cloud.
2. In the upload window, enter the information as follows:
   - Destination: select where you want to upload the preset.
   - Preset name: name of the preset as it will display once uploaded.
   - This preset belongs to which styles: select the styles or category for the preset.
Using Adjustment Presets

- **Description**: enter a short description of your preset.

- **Collection**: enter the name of the collection you want the preset added to.

- **Tags**: enter one or more keyword search tags that will help users find the preset when searching.

  *Note*: separate each tag you enter with a space. If you want to use two words as the tag, just put quotes around them, e.g. "dollar bill".

3. Click **Next** to proceed.

  *Note*: if you are not signed into DirectorZone, you will first be asked to sign in to continue.

4. Confirm the copyright disclaimer, and then click **Next** to proceed with the upload.

5. Click on **Close** to close the upload window.

Exporting/Import Presets

You can export your adjustment presets for import and use on another computer. To export an adjustment preset, do this:

1. Right-click on a preset and then select **Export**.

2. Enter a file name for the preset, and then select the location where you want to export it.

3. Click **Save**. CyberLink ColorDirector saves the preset in the .cdadj file format.

To import an adjustment preset, do this:

  *Note*: you can import adjustment presets in the .pdadj and .cdadj file formats via this import method. If you are trying to import an adjustment preset in either of these formats that you downloaded from DirectorZone, just double click on it.

1. Within the Downloaded Preset or My Created Presets section, click on **Import** and then select **Import**.

2. Browse to location of the preset file and then select **Open** to complete the import.
Chapter 8:

Turning Adjustments On/Off

You can turn off a set of adjustments applied to a video instantly. This allows you to reset the one type of adjustments, instead of resetting all the adjustments by clicking **Reset**.

To do this, just deselect the check box associated to the applied adjustments.

![White Balance Adjustments](image)

At any time you can turn the adjustments back on by re-selecting the check box.

*Note: you can also click the ![Reset button](image) if you would like to reset a set of adjustments back to the default values.*
Chapter 9:

Production

When you make adjustments to videos, the last step is to produce them, or render them with the edits and adjustments applied. CyberLink ColorDirector keeps a log of all the edits and adjustments you want to make to each video clip, and producing it applies all these adjustments and creates a new video file for you.

If there are multiple video clips in your project’s storyboard panel, the production feature renders all the clips into one longer video movie file. You can render them in a variety of video file formats.

*Note:* if you have CyberLink PowerDirector 11 or above installed on your computer, you can also select File > Export Project to PowerDirector from the menu to quickly send all the individual adjusted video clips in the storyboard directly to the PowerDirector timeline.

To produce your video clips, click the **Production** button to open the Production module.

**Producing Video Files**

You can produce your videos and render them as video files in the HEVC (H.265), AVC (H.264), XAVC S™, MPEG-2, or WMV format.

*Note:* projects with a 9:16 or 360º aspect ratio can only be produced using the AVC (H.264) video profile.

To produce a video, do this:

1. Click the **Production** button, and then on the **Video File** tab if necessary.
2. Specify the **Output folder**, or the location where the produced video file is saved. Click ![Folder button] if you want to select another output folder or change the name of the produced file.

*Note:* if you have a CyberLink Cloud subscription you can select the **Upload a copy to CyberLink Cloud** option if you also want the program to upload the produced file to your CyberLink Cloud storage space after production.

3. **Select an output format** by selecting the corresponding button.

*Note:* if you select the **HEVC (H.265)** or **AVC (H.264)** output format, you must also select the container from the drop-down. You can choose from the .M2TS, .MKV, or .MP4 container file format.
4. Select the **Country/Video format** (NTSC or PAL) for your video. This format should correspond to the region in which you plan to play your video.

5. Select the **Profile name/quality** you want to use to create the file. The resolutions that are available is based on your project's aspect ratio. If you are producing the video in the .WMV format, select the **Profile type.** This selection determines the video resolution, file size, and overall quality of the outputted file. See **Customizing Profiles** for more information.

   **Note:** if you previously created a custom profile, it is available in **Profile name/quality** drop down when you select **Custom** in the **Profile type** drop-down.

6. Configure the production options as required. See **Configuring Production Options** for more information.

7. Click **Start** to begin. CyberLink ColorDirector proceeds to produce and create the video file.

   **Note:** if you selected to upload a copy of the produced file to CyberLink Cloud, ColorDirector will ask you if you want to convert it before uploading. Click **Yes** to convert it to an .MP4 file that is playable on a portable device, or **No** if you want to upload the original produced file.

### Producing 360° Video

360° video files are outputted using the same method as regular 2D files. The only difference is that they can only be outputted using the H.264 AVC (.MP4) format.

   **Note:** for your file to be produced as a 360° video file, your project aspect ratio must be set to 360°. See **Setting Project Aspect Ratio** for more information.

Once the production is complete, you play the 360° video file in 360° mode, with a compatible VR (virtual reality) device, or you can upload and then play it on YouTube or Vimeo. See **Uploading 360° Video to YouTube** and **Uploading 360° Video to Vimeo**.

### Customizing Profiles

After you select a file format for your outputted file, depending on the format you selected, there may be quality settings you can customize in the profiles section. These quality settings are called profiles, and can consist of a video file's resolution, bitrate compression, audio compression type, and more.

In the production options section you can:

- click **+** to create your own custom video profile from scratch.
Production

- select an existing profile, and then click to edit it to fit your requirements.

- click to view a profile's details, or to delete a custom profile you created previously.

Before you output your production, you may want to create a new quality profile, edit an existing one, or select a different existing profile, and other options from one of the available drop-downs in the production options section.

**Configuring Production Options**

Before you begin producing your file, you can select from the following production options:

- **Enable preview during production**: select this option to preview your video during production. Selecting this option will increase the time required to produce your video file.

- **Hardware video encoding**: select this option to reduce production time. The Hardware video encoding option is only enabled if your computer supports hardware acceleration (NVIDIA graphics card that supports CUDA, an AMD graphics card that supports AMD Accelerated Parallel Processing, or a computer with Intel Core Processor Family technology), and you are outputting in a format that's supported by your graphics card.

- **Intel Quick Sync Video**: if your computer supports Intel Quick Sync Video, and you are outputting in a format that's supported by your graphics card, then this option is available. Select it to reduce production time.

- **x.v.Color**: x.v.Color is a color system that can display a wider color range than usual. CyberLink ColorDirector can generate an x.v.Color-compliant stream, which is backward compatible with RGB displays, while offering the opportunity to achieve better visual quality if your playback environment is x.v.Color ready.

**Sharing Videos**

You can share the changes you made to the videos on the storyboard by uploading them to YouTube or Vimeo. To do this, click on the Production button and then select the Online tab.
Uploading Videos to YouTube

To upload your video to YouTube, do this:

1. Click the Production button, and then on the Online tab.

2. Specify the Output folder, or the location where the produced video file that will be uploaded is saved. Click if you want to select another output folder or change the name of the produced file.

   Note: if the size/length of the your video exceeds the maximum allowed, CyberLink ColorDirector will separate the video into smaller/shorter videos, upload these videos, and then create a playlist for you on YouTube.

3. Click the YouTube Videos button.

4. Select the desired quality of your video from the Profile type drop-down. The quality you select will result in the corresponding quality option being available after the video is fully processed on YouTube.

   Note: the quality option available on YouTube is also dependent on the original captured video quality and the bandwidth of the user who is watching the video.

5. Enter a Title and Description for your video in the fields provided. The text you enter is included on YouTube once uploaded. Also select one of the Video categories and enter in some keyword Tags that users can search for to find your video.

6. Set whether you want the video to be Public or Private once it is uploaded to YouTube.

   Note: sign in to DirectorZone and then select Share in CyberLink DirectorZone Video Gallery if you want to show others how you adjusted the clips in your video production. When selected, an animated version of your project’s storyboard displays, along with your uploaded video, on DirectorZone.

7. Configure the production options as required. See Configuring Production Options for more information.

8. Click Start to begin.

9. Click Authorize and then grant CyberLink ColorDirector permission to upload videos to your YouTube account by following the steps in the YouTube Authorization windows.

10. CyberLink ColorDirector proceeds to produce and upload the video file. Click Close when done to return to the program.
Uploading 360° Videos to YouTube

On the Online tab you can upload your 360° video to YouTube. The upload process is the same as above for regular 2D video, except only 360° video profiles are available in the Profile type drop-down.

Note: for your file to be produced and uploaded as a 360° video file, your project aspect ratio must be set to 360°. See Setting Project Aspect Ratio for more information.

Once uploaded, you can click and drag on the YouTube player window, or use any available 360 controls, to rotate and view the entire 360° video.

Configuring Production Options

Before you begin producing, you can select the following production options:

- **Hardware video encoding**: this option is only enabled if your computer supports hardware acceleration (an AMD graphics card that supports AMD Accelerated Parallel Processing), and you are outputting in a file format that supports it.

- **Enable preview during production**: select this option to preview your movie during production. Selecting this option will increase the time required to produce your file.

Uploading Videos to Vimeo

To upload your video to Vimeo, do this:

1. Click the Production button, and then on the Online tab.
2. Specify the Output folder, or the location where the produced video file that will be uploaded is saved. Click if you want to select another output folder or change the name of the produced file.

Note: if the size/length of the your video exceeds the maximum allowed, CyberLink ColorDirector will separate the video into smaller/shorter videos, upload these videos, and then create a playlist for you on Vimeo.
3. Click the Vimeo button.
4. Select the desired quality of your video from the Profile type drop-down. The quality you select will result in the corresponding quality option being available after the video is fully processed on Vimeo.

Note: the quality option available on Vimeo is also dependent on the original captured video quality and the bandwidth of the user who is watching the video.

3. Enter a Title and Description for your video in the fields provided. The text you enter is included on Vimeo once uploaded. Also enter in some keyword Tags that users can search for to find your video.

4. Set whether you want the video to be Public or Private once it is uploaded to Vimeo.

Note: sign in to DirectorZone and then select Share in CyberLink DirectorZone Video Gallery if you want to show others how you adjusted the clips in your video production. When selected, an animated version of your project’s storyboard displays, along with your uploaded video, on DirectorZone.

5. Configure the production options as required. See Configuring Production Options for more information.

6. Click Start to begin.

7. Click Authorize and then grant CyberLink ColorDirector permission to upload videos to your Vimeo account by following the steps in the Vimeo Authorization windows.

8. CyberLink ColorDirector proceeds to produce and upload the video file. Click Close when done to return to the program.

Uploading 360° Videos to Vimeo

On the Online tab you can upload your 360° video to Vimeo. The upload process is the same as above for regular 2D video, except only 360° video profiles are available in the Profile type drop-down.

Note: for your file to be produced and uploaded as a 360° video file, your project aspect ratio must be set to 360°. See Setting Project Aspect Ratio for more information.

Once uploaded, you can click and drag on the Vimeo player window, or use any available 360 controls, to rotate and view the entire 360° video.

Configuring Production Options

Before you begin producing, you can select the following production options:
• **Hardware video encoder**: this option is only enabled if your computer supports hardware acceleration (an AMD graphics card that supports AMD Accelerated Parallel Processing), and you are outputting in a file format that supports it.

• **Enable preview during production**: select this option to preview your movie during production. Selecting this option will increase the time required to produce your file.
Chapter 10:

ColorDirector Preferences

To set your program preferences in CyberLink ColorDirector, just click the button or press the Alt+C keys on your keyboard.

General Preferences

Click the button to open the Preferences window, and then select the General tab. The available options are as follows:

Application:

- **Frame rate**: select the frame rate and TV format (NTSC or PAL) for your video. The frame rate should correspond to the source video footage being adjusted. The TV format should correspond to the region in which you plan to play your produced video (if you burn it to disc).

- **Drop frame timecode**: if your selected TV format is NTSC, select "Yes" to synchronize the timecode of your video to its video length in the storyboard panel.

- **Auto delete temporary files every**: select to have CyberLink ColorDirector automatically delete temporary files created while editing, every specified number of days. Or click the Manually Delete button to delete all the current temporary files to free up disc space.

Internet:

- **Automatically check for software updates**: select to periodically check for updates or new versions of ColorDirector automatically.

Language:

- **Use system default language (if supported)**: select this option for the language display to be the same as the language of your operating system. This feature is only available if your operating system’s language is one of the supported user defined languages.

- **User defined**: select this option and then select the language from the drop-down list that you want to use.
**ColorDirector Preferences**

**Messages:**

- Click the **Reset** button to reset the all the "Don't show again" checkboxes in the program's message dialogs back to the default settings. All of the message dialogs that contain the "Don't show again" checkbox will display again after this button is clicked.

**Project Preferences**

Click the **button** to open the Preferences window, and then select the **Project** tab. The available options are as follows:

- **Auto save project every:** select this to automatically save your project every specified number of minutes, so you don't lose your changes by accident. If you want to set a specific location for the auto save files, click the **button** and select a folder location on your computer.

**DirectorZone Preferences**

Click the **button** to open the Preferences window, and then select the **DirectorZone** tab. The available options are as follows:

**Sign in:**

- enter in your **E-mail** address and **Password**, and then click the **Sign in** button to sign in to DirectorZone. If you do not have a DirectorZone account, click on the **Get an Account** link.

- **Auto sign in to DirectorZone:** select this option to automatically sign in to DirectorZone when the program is opened.

  *Note:* you can sign out from DirectorZone at any time by returning to this tab, and then clicking the **Sign out** button.

**Privacy rules:**

- **Allow DirectorZone to gather editing information:** select this option to allow DirectorZone to make a list of all the adjustments you made to the video clips when uploading them to social media web sites.
Color Preferences

Click the button to open the Preferences window, and then select the Color tab. The available options are as follows:

- **Apply color lookup table**: select this option and then click to import a color lookup table (CLUT) and apply it to all of the video clips on the storyboard. The imported color lookup table will be applied to all future imported video clips until you deselect this option or apply another color lookup table.

  *Note*: see Applying Color Lookup Tables (CLUT) for more information on applying color lookup tables.

Hardware Acceleration Preferences

Click the button to open the Preferences window, and then select the Hardware Acceleration tab. The available options are as follows:

**Hardware acceleration**:

- **Enable hardware acceleration for video decoding**: if your computer supports NVIDIA CUDA/AMD Accelerated Parallel Processing/Intel Core Processor Family technology, select this option to use hardware acceleration to decode the video during the adjustment process and when previewing videos.

- **Enable OpenCL for video encoding**: if your computer supports GPU hardware acceleration, select this option to speed up the encoding of video by tapping into the multi-core parallel processing power of your computer.

Production Preferences

Click the button to open the Preferences window, and then select the Production tab. The available options are as follows:

**Produce**: 
• **Reduce video blocky artifacts (Intel SSE4 optimized):** select this option to improve the overall production quality of produced video, if your computer supports Intel SSE4 optimization.

**CyberLink Cloud Preferences**

Click the button to open the Preferences window, and then select the CyberLink Cloud tab. The available options are as follows:

• **Back up and restore your preferences:** if you have a CyberLink Cloud subscription you can click **Back up to CyberLink Cloud** to back up program preferences and custom output profiles to CyberLink Cloud. Click **Restore from CyberLink Cloud** to replace your current program preferences with the ones you previously backed up on CyberLink Cloud.

• **Download folder:** click the button to change the folder where CyberLink Cloud presets, projects, and media are stored when downloaded.

• **Clear CyberLink Cloud cache:** click the **Clear Offline Cache** button to free up some disk space by emptying the temp files stored when downloading content from CyberLink Cloud.

• **Sign out from CyberLink Cloud service:** if you are currently signed in to CyberLink Cloud, click the button to sign yourself out.

**Note:** click the Account Information link in the bottom right corner of the preferences windows if you want to know your CyberLink Cloud subscription expiry date, how much storage space you have, and more.

**Improvement Program Preferences**

Click the button to open the Preferences window, and then select the Improvement Program tab. The available options are as follows:

**CyberLink Product Improvement Program**

• **I want to participate:** select this item if you would like to participate in the CyberLink Product Improvement Program for ColorDirector. Once enabled, CyberLink ColorDirector will collect information about the hardware and software configuration of your computer system, as well as your usage
behavior and statistics related to the software. Click the Read more information about the improvement program online link to view more detailed information about the content collected.

Note: the CyberLink Product Improvement Program for ColorDirector will not collect any personal information for purposes of identifying you.
Chapter 11: 

ColorDirector Hotkeys

The following is a list of the hotkeys available in CyberLink ColorDirector for your convenience. If required, you can customize your keyboard hotkeys in the Customize Hotkeys window.

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Description</th>
<th>Module Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+W</td>
<td>New workspace and return to Library module</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Create new project</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open existing project</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save current project</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Save as a new project</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Pack project materials</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Import video files</td>
<td>Library</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Import video folder</td>
<td>Library</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Exit CyberLink ColorDirector</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo last adjustment setting</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Redo last adjustment setting</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Reset adjustments to default settings</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all videos in the storyboard panel</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Deselect all videos in the storyboard panel</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Hotkey</td>
<td>Description</td>
<td>Module Available</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+K</td>
<td>Show/Hide keyframe settings panel</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Split the selected video clip at the current location</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+Alt+T</td>
<td>Open trim window</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+Alt+D</td>
<td>Open the Detect Scenes window</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>+</td>
<td>Zoom in on the keyframe timeline</td>
<td>Adjustment</td>
</tr>
<tr>
<td>-</td>
<td>Zoom out on the keyframe timeline</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Shift+Enter</td>
<td>Add new keyframe</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Shift+Delete</td>
<td>Delete selected keyframe</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+Shift+Delete</td>
<td>Delete all keyframes at current timeline position</td>
<td>Adjustment</td>
</tr>
<tr>
<td>M</td>
<td>Add timeline marker to the keyframe timeline</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Track one frame only</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Esc</td>
<td>Cancel regional adjustment/current action</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+C</td>
<td>Open Preferences window</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Shift+Left</td>
<td>Go to previous keyframe</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+Shift+Right</td>
<td>Go to next keyframe</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Up</td>
<td>Scroll up when mouse over adjustment slider</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Down</td>
<td>Scroll down when mouse over adjustment slider</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Shift</td>
<td>Use straight line control to create horizontal and vertical</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Hotkey</td>
<td>Description</td>
<td>Module Available</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Left arrow</td>
<td>One unit back on the selected tool slider</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Right arrow</td>
<td>One unit forward on the selected tool slider</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Scroll up when mouse over adjustment slider</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Scroll down when mouse over adjustment slider</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Mouse Wheel Up</td>
<td>Increase motion tracking brush size</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Mouse Wheel Down</td>
<td>Decrease motion tracking brush size</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+Mouse Wheel</td>
<td>Switch to and resize eraser when using the motion tracking mask brush</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+Mouse Wheel Up</td>
<td>Zoom in on video viewer window</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+Mouse Wheel Down</td>
<td>Zoom out on video viewer window</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+H</td>
<td>Customize hotkeys</td>
<td>All</td>
</tr>
</tbody>
</table>

**View**

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
<th>Module Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>F6</td>
<td>Switch to viewer &amp; storyboard mode in video viewer window</td>
<td>All</td>
</tr>
<tr>
<td>F7</td>
<td>Switch to viewer only mode in video viewer window</td>
<td>All</td>
</tr>
<tr>
<td>F</td>
<td>Go to full screen</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Alt+Z</td>
<td>Open video zoom list view</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Alt+1</td>
<td>Toggle show one mode on/off</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Hotkey</td>
<td>Description</td>
<td>Module Available</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Alt+2</td>
<td>Toggle compare before/after mode on/off</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+3</td>
<td>Toggle split left/right mode on/off</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+4</td>
<td>Toggle top/bottom mode on/off</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+5</td>
<td>Toggle split top/bottom mode on/off</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+B</td>
<td>Set video viewer background color</td>
<td>All</td>
</tr>
</tbody>
</table>

**Playback**

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Description</th>
<th>Module Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Bar</td>
<td>Play/Pause video playback</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+/</td>
<td>Stop video playback</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Fast forward video playback</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Access video volume control</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Backspace</td>
<td>Toggle mute on/off</td>
<td>All</td>
</tr>
<tr>
<td>,</td>
<td>Go to previous frame</td>
<td>All</td>
</tr>
<tr>
<td>.</td>
<td>Go to next frame</td>
<td>All</td>
</tr>
<tr>
<td>Home</td>
<td>Go to first video clip on the storyboard</td>
<td>All</td>
</tr>
<tr>
<td>End</td>
<td>Go to last video clip on the storyboard</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Left Arrow</td>
<td>Go to previous clip/scene</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Right Arrow</td>
<td>Go to next clip/scene</td>
<td>All</td>
</tr>
<tr>
<td>, or Shift+Mouse Wheel Up</td>
<td>Go to previous frame</td>
<td>All</td>
</tr>
<tr>
<td>. or Shift+Mouse Wheel Down</td>
<td>Go to next frame</td>
<td>All</td>
</tr>
</tbody>
</table>

**Workspace**
## ColorDirector Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Description</th>
<th>Module Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+F9</td>
<td>Go to Library module</td>
<td>Adjustment, Production</td>
</tr>
<tr>
<td>Alt+F10</td>
<td>Go to Adjustment module</td>
<td>Library, Production</td>
</tr>
<tr>
<td>Alt+F11</td>
<td>Go to Production module</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+Alt+M</td>
<td>Toggle mirror mode on/off (secondary monitor only)</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+Alt+A</td>
<td>Toggle alternate mode on/off (primary monitor only)</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+Alt+N</td>
<td>Select to display nothing on the secondary monitor</td>
<td>Adjustment</td>
</tr>
<tr>
<td><strong>System</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F1</td>
<td>Open CyberLink ColorDirector help</td>
<td>All</td>
</tr>
<tr>
<td>Delete</td>
<td>Remove selected videos from the library/storyboard</td>
<td>All</td>
</tr>
<tr>
<td>Shift+F12</td>
<td>View CyberLink ColorDirector hotkeys list</td>
<td>All</td>
</tr>
<tr>
<td>Alt+F</td>
<td>Open [File] menu</td>
<td>All</td>
</tr>
<tr>
<td>Alt+E</td>
<td>Open [Edit] menu</td>
<td>All</td>
</tr>
<tr>
<td>Alt+V</td>
<td>Open [Video] menu</td>
<td>All</td>
</tr>
<tr>
<td>Alt+I</td>
<td>Open [View] menu</td>
<td>All</td>
</tr>
<tr>
<td>Alt+M</td>
<td>Open [Help] menu</td>
<td>All</td>
</tr>
</tbody>
</table>

### Customizing Keyboard Hotkeys

CyberLink ColorDirector lets you fully customize its keyboard shortcut hotkeys to fit your requirements.

To customize the keyboard hotkeys, do this:

*Note: click the Restore button if you need to reset a selected hotkey that you customized, to the default value.*
1. Select **Edit > Keyboard Hotkeys > Customize** from the menu. Or just press the Alt+H keys on your keyboard to open the Customize Keyboard Hotkeys window.

2. Browse to and find the hotkey command that you want to customize.
   
   **Note:** if required, enter in a search keyword in the field provided for the hotkey command you want to customize and then click search icon. Click it repeatedly to locate multiple instances of the inputted search keyword, if required.

3. Click in the **Hotkeys** column next to the command you want to customize.

4. Press the hotkey combination on your computer’s keyboard that you want to use/replace the existing hotkey with.
   
   **Note:** if the keyboard hotkey you specify is already in use in the program, you will be asked if you want to remove it from the existing command to use in the new specified command. The replaced command will no longer have a keyboard hotkey associated to it.

5. Repeat the above steps to customize all the keyboard hotkeys to your preference.

6. Once you are done, click the **OK** button, enter a name for the new set of customized keyboard hotkeys, and then click **OK** to apply and save the changes.

## Hotkey Sets

When you customize keyboard hotkeys in CyberLink ColorDirector, they are saved as hotkey sets in the Customize Keyboard Hotkeys window. If required you can create multiple sets of hotkeys, which are quickly accessible in the window.

In the Customize Keyboard Hotkeys window, you can:

- quickly switch among the saved hotkey sets by selecting the one you want to use from the **Hotkey sets** drop-down. Select the **ColorDirector Default** hotkey set to use the original hotkey settings.

- edit an existing hotkey set by further customizing the keyboard hotkeys, and then clicking the **Save as** button to save it as a brand new hotkey set.

- delete a custom hotkey set by selecting it in the **Hotkey set** drop-down and then clicking the **Delete** button.
Importing and Exporting Hotkey Sets

In the Customize Keyboard Hotkeys window you can export all of the hotkey sets you created. This saves the custom hotkey set to a file that can then be imported into another version of CyberLink ColorDirector that supports the importing of hotkey sets.

To export a hotkey set, do this:

1. Select **Edit > Keyboard Hotkeys > Export** from the CyberLink ColorDirector menu.
2. Specify a file name and save location on your computer.
3. Click the **Save** button to complete export process.

To import a hotkey set, do this:

1. Select **Edit > Keyboard Hotkeys > Import** from the CyberLink ColorDirector menu.
2. Browse to the location of the exported file in the .CDH file format.
3. Click the **Open** button to complete the import process.
Chapter 12:

Licenses and Copyrights

Below are the applicable licenses and copyright information that pertain to the components listed in the List of Components.

**XAVC S**

XAVC S and are trademarks of Sony Corporation.
Chapter 13:

Technical Support

If you require technical support, then this chapter can help. It includes all the information you need to find the answers you are looking for. You may also find answers quickly by contacting your local distributor/dealer.

Before Contacting Technical Support

Before contacting CyberLink technical support, please take advantage of one or more of the following free support options:

- consult the user’s guide or the online help installed with your program.
- refer to the Knowledge Base at the following link on the CyberLink web site: https://www.cyberlink.com/support/search-product-result.do
- check the Help Resources page in this document.

When contacting technical support by e-mail or phone, please have the following information ready:

- registered **product key** (your product key can be found on the software disc envelope, the box cover, or in the e-mail received after you purchased CyberLink products on the CyberLink store).
- the product name, version and build number, which generally can be found by clicking on the product name image on the user interface.
- the version of Windows installed on your system.
- list of hardware devices on your system (capture card, sound card, VGA card) and their specifications. For fastest results, please generate and attach your system info using the DxDiag.txt.

*Note: here are the steps to generate the system info DxDiag.txt file: Click Windows (start) button, and then search for "dxdiag". Click **Save All Information** button to save the DxDiag.txt file.*

- the wording of any warning messages that were displayed (you may want to write this down or take a screen capture).
• a detailed description of the problem and under what circumstances it occurred.

Web Support

Solutions to your problems are available 24 hours a day at no cost on the CyberLink web site:

*Note: you must first register as a member before using CyberLink web support.*

CyberLink provides a wide range of web support options, including FAQs, in the following languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Web Support URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td><a href="https://www.cyberlink.com/cs-help">https://www.cyberlink.com/cs-help</a></td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td><a href="https://tw.cyberlink.com/cs-help">https://tw.cyberlink.com/cs-help</a></td>
</tr>
<tr>
<td>Japanese</td>
<td><a href="https://jp.cyberlink.com/cs-help">https://jp.cyberlink.com/cs-help</a></td>
</tr>
<tr>
<td>Spanish</td>
<td><a href="https://es.cyberlink.com/cs-help">https://es.cyberlink.com/cs-help</a></td>
</tr>
<tr>
<td>Korean</td>
<td><a href="https://kr.cyberlink.com/cs-help">https://kr.cyberlink.com/cs-help</a></td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td><a href="https://cn.cyberlink.com/cs-help">https://cn.cyberlink.com/cs-help</a></td>
</tr>
<tr>
<td>German</td>
<td><a href="https://de.cyberlink.com/cs-help">https://de.cyberlink.com/cs-help</a></td>
</tr>
<tr>
<td>Italian</td>
<td><a href="https://it.cyberlink.com/cs-help">https://it.cyberlink.com/cs-help</a></td>
</tr>
</tbody>
</table>

Help Resources

The following is a list of help resources that may assist you when using any of CyberLink's products.

• Access CyberLink's Knowledge base and FAQ (frequently asked questions): https://www.cyberlink.com/cs-resource

• View video tutorials and more for your software in the CyberLink Learning Center: https://www.cyberlink.com/learning

• Ask questions and get answers from our users on the CyberLink Community Forum: https://forum.cyberlink.com/forum/forums/list/ENU.page
Note: CyberLink’s user community forum is only available in English and German.
Index

2

2-way 74

3

360° video
aspect ratio 22
importing 5
playing 20
previewing 5
producing 89
projects 22
rendering 89
sharing 92, 93
uploading 92, 93
3-way 75

A

Adjustments
global tools 65
overview 34
presets 82
regional tools 38
resetting 87
turning off/on 87
Aspect ratio
setting 22
Auto denoise 71
Auto save 96
Auto tone 66

AVC 88

B

Bézier curve 40
Black and white 37
Blur 78
Brightness 62

C

Clarity 62, 67
Clipped areas 37
CLUT
applying 35
creating 35
Codecs 88
Color
lookup table 35
preferences 97
remapping 79
replacement 64
replacing 77
shifting 79
splash 79
Color match 75
ColorDirector
365 2
Contrast 62, 66
Controls
motion tracking 20
playback 19
Curve 69
CyberLink Cloud
account information 98
CyberLink Cloud
downloading presets 83
downloading videos 7
overview 1
packing project materials 23
preferences 98
projects 23
signing out 98
uploading presets 85
uploading projects 23
uploading videos 88

Equirectangular 5
Export 88
projects 23
to CyberLink Cloud 23
Exposure 62, 66
Extend 17

F
Fit 19
Full screen 19

G
Global adjustment tools 65
Glow 76
Gradient mask 51
Gradual change 31
Grayscale 37
mixing 73

H
H.264 88
H.265 88
Hardware acceleration
preferences 97
HDR effect 76
Help 109
HEVC 88
Histogram 35
level 68
Horizontal 40
Hotkeys 100
customizing 104

D
Detail 70
DirectorZone
downloading presets 82
overview 1
preferences 96
sign in/out 96
uploading presets 85
Display mode 17
Download
presets 82
projects 23
videos 7

E
Edge 76
Edge mask 70
Effects
HDR 76
keyframes 30
Ellipse 57
Index

Hue 71

I

Import
  presets 86
  videos 5
Instant change 31
Interpolation 41, 48, 53, 58
Invert
  motion tracking mask 47
  selection mask 41

K

Keyframes
  adding 30
  behavior 31
  settings 24
  settings panel 12

L

Language 95
Level 68
Library
  sorting 9, 10
  view 10
Lightness 72
  black and white 73
Lomo 74
Luminance 71
LUT
  applying 35
  creating 35

M

M2TS 88
Markers
  timeline 28
Masks
  gradient 51
  interpolation 41, 48, 53, 58
  inverting 41, 47
  motion tracking 45
  radial filter 57
  selection 38
Metadata 11
Mix 73
MKV 88
Motion tracking controls 20
Motion tracking mask 45

N

Never show again 95
Noise reduction 71
NTSC 95

O

Options 20
Overexposed 37

P

PAL 95
PowerDirector 88
Preferences 95
Presets 82
Presets 82
  CyberLink Cloud 85
  DirectorZone 85
downloading 82
importing 86
level 68
uploading 85
Product Improvement Program 98
Production
  module 88
  preferences 97
  videos 88
Projection format 5
Projects
  CyberLink Cloud 23
downloading 23
  exporting 23
  saving 22
  uploading 23

S
Saturation 62, 67, 72
Save
  projects 22
Secondary monitor 17
Selection mask 40
  straight line control 40
    using 38
Share 90
Sharpness 70
Snap control 40
Soft focus 78
Sort 10
Split toning 74
Straight line control 40
Supported formats 5
System requirements 4

Q
Quality 20

R
Radial filter 57
Radius 70, 76
Range selection 17
Real-time preview 20
Regional adjustment tools 38
Render preview 17
Reset 87
RGB 35

T
Technical support 108
Temperature 65
Timecode 95
Timeline
  adding markers 28
Tint 65
Tint filter 78
Tone 66
Turn off/on 87
TV format 95
Index

U

UI language 95
Underexposed 37
Updates 3
Upload
  presets 85
  projects 23
  videos 88

V

Versions 2
Vertical 40
Vibrance 62, 67
Video browser
  view mode 18
Videos
  black and white 37
  blur 78
  color replacement 64, 77
  decoding 97
  downloading 7
  encoding 90
  importing 5
  importing 360° 5
  information 11
  keyframes 24
  playing back 19
  producing 88
  quality 20
  resolution 20
  sharing 90
  soft focus 78

  sorting 9, 10
  split toning 74
  supported formats 5
  tint filter 78
  uploading 88
  virtual reality 5
  zooming 19

View mode 18
Viewer
  zooming 19
Vignetting effect 78
Vimeo 92
  360° video 93
Virtual reality
  Vimeo 93
  YouTube 92

Virtual reality
  importing video 5
  playing videos 20
  previewing 5
  producing video 89
  projects 22
  rendering video 89

W

Web support 109
White balance 65
Workspace
  creating new 22

X

x.v.Color 90
XAVC S 88
Y

YouTube 91
  360° video 92

Z

Zoom 19